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UNIT-1 

INTRODUCTION  OF  COMPUTER 

Functionalities of a Computer 

If we look at it in a very broad sense, any digital computer carries out the following five 
functions − 

Step 1 − Takes data as input. 

Step 2 − Stores the data/instructions in its memory and uses them as required. 

Step 3 − Processes the data and converts it into useful information. 

Step 4 − Generates the output. 

Step 5 − Controls all the above four steps. 

 

Advantages of Computers 

Following are certain advantages of computers. 

High Speed 

 Computer is a very fast device. 

 It is capable of performing calculation of very large amount of data. 

 The computer has units of speed in microsecond, nanosecond, and even the picosecond. 

 It can perform millions of calculations in a few seconds as compared to man who will spend 
many months to perform the same task. 

Accuracy 

 In addition to being very fast, computers are very accurate. 

 The calculations are 100% error free. 
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 Computers perform all jobs with 100% accuracy provided that the input is correct. 

Storage Capability 

 Memory is a very important characteristic of computers. 

 A computer has much more storage capacity than human beings. 

 It can store large amount of data. 

 It can store any type of data such as images, videos, text, audio, etc. 

Diligence 

 Unlike human beings, a computer is free from monotony, tiredness, and lack of 
concentration. 

 It can work continuously without any error and boredom. 

 It can perform repeated tasks with the same speed and accuracy. 

Versatility 

 A computer is a very versatile machine. 

 A computer is very flexible in performing the jobs to be done. 

 This machine can be used to solve the problems related to various fields. 

 At one instance, it may be solving a complex scientific problem and the very next moment it 
may be playing a card game. 

Reliability 

 A computer is a reliable machine. 

 Modern electronic components have long lives. 

 Computers are designed to make maintenance easy. 

Automation 

 Computer is an automatic machine. 

 Automation is the ability to perform a given task automatically. Once the computer receives 
a program i.e., the program is stored in the computer memory, then the program and 
instruction can control the program execution without human interaction. 

Reduction in Paper Work and Cost 

 The use of computers for data processing in an organization leads to reduction in paper 
work and results in speeding up the process. 
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 As data in electronic files can be retrieved as and when required, the problem of 
maintenance of large number of paper files gets reduced. 

 Though the initial investment for installing a computer is high, it substantially reduces the 
cost of each of its transaction. 

Disadvantages of Computers 

Following are certain disadvantages of computers. 

No I.Q. 

 A computer is a machine that has no intelligence to perform any task. 

 Each instruction has to be given to the computer. 

 A computer cannot take any decision on its own. 

Dependency 

 It functions as per the user‟s instruction, thus it is fully dependent on humans. 

Environment 

 The operating environment of the computer should be dust free and suitable. 

No Feeling 

 Computers have no feelings or emotions. 

 It cannot make judgment based on feeling, taste, experience, and knowledge unlike 
humans. 

Computer - Applications 
application of computers in various fields. 
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Business 

 

A computer has high speed of calculation, diligence, accuracy, reliability, or 

versatility which has made it an integrated part in all business 

organizations. 

Computer is used in business organizations for − 

 Payroll calculations 

 Budgeting 

 Sales analysis 

 Financial forecasting 

 Managing employee database 

 Maintenance of stocks, etc. 
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Banking 

 

Today, banking is almost totally dependent on computers. 

Banks provide the following facilities − 

 Online accounting facility, which includes checking current balance, making 

deposits and overdrafts, checking interest charges, shares, and trustee records. 

 ATM machines which are completely automated are making it even easier for 

customers to deal with banks. 

Insurance 
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Insurance companies are keeping all records up-to-date with the help of 

computers. Insurance companies, finance houses, and stock broking firms 

are widely using computers for their concerns. 

Insurance companies are maintaining a database of all clients with 

information showing − 

 Procedure to continue with policies 

 Starting date of the policies 

 Next due installment of a policy 

 Maturity date 

 Interests due 

 Survival benefits 

 Bonus 

Education 

 

The computer helps in providing a lot of facilities in the education system. 

 The computer provides a tool in the education system known as CBE (Computer 

Based Education). 

 CBE involves control, delivery, and evaluation of learning. 

 Computer education is rapidly increasing the graph of number of computer 

students. 

 There are a number of methods in which educational institutions can use a 

computer to educate the students. 
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 It is used to prepare a database about performance of a student and analysis is 

carried out on this basis. 

Marketing 
In marketing, uses of the computer are following − 

 

 Advertising − With computers, advertising professionals create art and 

graphics, write and revise copy, and print and disseminate ads with the goal of 

selling more products. 

 Home Shopping − Home shopping has been made possible through the use of 

computerized catalogues that provide access to product information and permit 

direct entry of orders to be filled by the customers. 

Healthcare 
Computers have become an important part in hospitals, labs, and 

dispensaries. They are being used in hospitals to keep the record of patients 

and medicines. It is also used in scanning and diagnosing different diseases. 

ECG, EEG, ultrasounds and CT scans, etc. are also done by computerized 

machines. 

Following are some major fields of health care in which computers are used. 
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 Diagnostic System − Computers are used to collect data and identify the 

cause of illness. 

 Lab-diagnostic System − All tests can be done and the reports are prepared 

by computer. 

 Patient Monitoring System − These are used to check the patient's signs for 

abnormality such as in Cardiac Arrest, ECG, etc. 

 Pharma Information System − Computer is used to check drug labels, expiry 

dates, harmful side effects, etc. 

 Surgery − Nowadays, computers are also used in performing surgery. 

Engineering Design 
Computers are widely used for Engineering purpose. 

One of the major areas is CAD (Computer Aided Design) that provides 

creation and modification of images. Some of the fields are − 
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 Structural Engineering − Requires stress and strain analysis for design of 

ships, buildings, budgets, airplanes, etc. 

 Industrial Engineering − Computers deal with design, implementation, and 

improvement of integrated systems of people, materials, and equipment. 

 Architectural Engineering − Computers help in planning towns, designing 

buildings, determining a range of buildings on a site using both 2D and 3D 

drawings. 

Military 

 

Computers are largely used in defence. Modern tanks, missiles, weapons, 

etc. Military also employs computerized control systems. Some military 

areas where a computer has been used are − 

 Missile Control 

 Military Communication 

 Military Operation and Planning 

 Smart Weapons 
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Communication 
Communication is a way to convey a message, an idea, a picture, or speech 

that is received and understood clearly and correctly by the person for 

whom it is meant. Some main areas in this category are − 

 

 E-mail 

 Chatting 

 Usenet 

 FTP 

 Telnet 

 Video-conferencing 

Government 
Computers play an important role in government services. Some major 

fields in this category are − 

 

 Budgets 
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 Sales tax department 

 Income tax department 

 Computation of male/female ratio 

 Computerization of voters lists 

 Computerization of PAN card 

 Weather forecasting 

Computer - Generations 
Generation in computer terminology is a change in technology a computer 

is/was being used. Initially, the generation term was used to distinguish 

between varying hardware technologies. Nowadays, generation includes 

both hardware and software, which together make up an entire computer 

system. 

There are five computer generations known till date. Each generation has 

been discussed in detail along with their time period and characteristics. In 

the following table, approximate dates against each generation has been 

mentioned, which are normally accepted. 

Following are the main five generations of computers. 

S.No Generation & Description 

1 
First Generation 

The period of first generation: 1946-1959. Vacuum tube based. 

2 
Second Generation 

The period of second generation: 1959-1965. Transistor based. 

3 
Third Generation 

The period of third generation: 1965-1971. Integrated Circuit based. 

4 
Fourth Generation 

The period of fourth generation: 1971-1980. VLSI microprocessor based. 

https://www.tutorialspoint.com/computer_fundamentals/computer_first_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_second_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_third_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_fourth_generation.htm
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5 
Fifth Generation 

The period of fifth generation: 1980-onwards. ULSI microprocessor based. 

First Generation 
The period of first generation was from 1946-1959. The computers of first 

generation used vacuum tubes as the basic components for memory and 

circuitry for CPU (Central Processing Unit). These tubes, like electric bulbs, 

produced a lot of heat and the installations used to fuse frequently. 

Therefore, they were very expensive and only large organizations were able 

to afford it. 

In this generation, mainly batch processing operating system was used. 

Punch cards, paper tape, and magnetic tape was used as input and output 

devices. The computers in this generation used machine code as the 

programming language. 

 

The main features of the first generation are − 

 Vacuum tube technology 

https://www.tutorialspoint.com/computer_fundamentals/computer_fifth_generation.htm
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 Unreliable 

 Supported machine language only 

 Very costly 

 Generated a lot of heat 

 Slow input and output devices 

 Huge size 

 Need of AC 

 Non-portable 

 Consumed a lot of electricity 

Some computers of this generation were − 

 ENIAC 

 EDVAC 

 UNIVAC 

 IBM-701 

 IBM-650 

Second Generation 
The period of second generation was from 1959-1965. In this generation, 

transistors were used that were cheaper, consumed less power, more 

compact in size, more reliable and faster than the first generation machines 

made of vacuum tubes. In this generation, magnetic cores were used as the 

primary memory and magnetic tape and magnetic disks as secondary 

storage devices. 

In this generation, assembly language and high-level programming 

languages like FORTRAN, COBOL were used. The computers used batch 

processing and multiprogramming operating system. 
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The main features of second generation are − 

 Use of transistors 

 Reliable in comparison to first generation computers 

 Smaller size as compared to first generation computers 

 Generated less heat as compared to first generation computers 

 Consumed less electricity as compared to first generation computers 

 Faster than first generation computers 

 Still very costly 

 AC required 

 Supported machine and assembly languages 

Some computers of this generation were − 

 IBM 1620 

 IBM 7094 

 CDC 1604 

 CDC 3600 

 UNIVAC 1108 
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Third Generation 
The period of third generation was from 1965-1971. The computers of third 

generation used Integrated Circuits (ICs) in place of transistors. A single IC 

has many transistors, resistors, and capacitors along with the associated 

circuitry. 

The IC was invented by Jack Kilby. This development made computers 

smaller in size, reliable, and efficient. In this generation remote processing, 

time-sharing, multiprogramming operating system were used. High-level 

languages (FORTRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, ALGOL-68 

etc.) were used during this generation. 

 

The main features of third generation are − 

 IC used 

 More reliable in comparison to previous two generations 

 Smaller size 

 Generated less heat 

 Faster 

 Lesser maintenance 

 Costly 

 AC required 
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 Consumed lesser electricity 

 Supported high-level language 

Some computers of this generation were − 

 IBM-360 series 

 Honeywell-6000 series 

 PDP (Personal Data Processor) 

 IBM-370/168 

 TDC-316 

Fourth Generation 
The period of fourth generation was from 1971-1980. Computers of fourth 

generation used Very Large Scale Integrated (VLSI) circuits. VLSI circuits 

having about 5000 transistors and other circuit elements with their 

associated circuits on a single chip made it possible to have microcomputers 

of fourth generation. 

Fourth generation computers became more powerful, compact, reliable, and 

affordable. As a result, it gave rise to Personal Computer (PC) revolution. In 

this generation, time sharing, real time networks, distributed operating 

system were used. All the high-level languages like C, C++, DBASE etc., 

were used in this generation. 
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The main features of fourth generation are − 

 VLSI technology used 

 Very cheap 

 Portable and reliable 

 Use of PCs 

 Very small size 

 Pipeline processing 

 No AC required 

 Concept of internet was introduced 

 Great developments in the fields of networks 

 Computers became easily available 

Some computers of this generation were − 

 DEC 10 

 STAR 1000 
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 PDP 11 

 CRAY-1(Super Computer) 

 CRAY-X-MP(Super Computer) 

Fifth Generation 
The period of fifth generation is 1980-till date. In the fifth generation, VLSI 

technology became ULSI (Ultra Large Scale Integration) technology, 

resulting in the production of microprocessor chips having ten million 

electronic components. 

This generation is based on parallel processing hardware and AI (Artificial 

Intelligence) software. AI is an emerging branch in computer science, which 

interprets the means and method of making computers think like human 

beings. All the high-level languages like C and C++, Java, .Net etc., are 

used in this generation. 

 

AI includes − 

 Robotics 

 Neural Networks 
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 Game Playing 

 Development of expert systems to make decisions in real-life situations 

 Natural language understanding and generation 

The main features of fifth generation are − 

 ULSI technology 

 Development of true artificial intelligence 

 Development of Natural language processing 

 Advancement in Parallel Processing 

 Advancement in Superconductor technology 

 More user-friendly interfaces with multimedia features 

 Availability of very powerful and compact computers at cheaper rates 

Some computer types of this generation are − 

 Desktop 

 Laptop 

 NoteBook 

 UltraBook 

 ChromeBook 

 

 Types of Computer  
Computers can be broadly classified by their speed and computing power. 

S.No. Type Specifications 

1 
PC (Personal 

Computer) 

It is a single user computer system 
having moderately powerful 

microprocessor 

2 Workstation 

It is also a single user computer 

system, similar to personal 
computer however has a more 
powerful microprocessor. 
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3 Mini Computer 

It is a multi-user computer system, 

capable of supporting hundreds of 
users simultaneously. 

4 Main Frame 

It is a multi-user computer system, 
capable of supporting hundreds of 
users simultaneously. Software 

technology is different from 
minicomputer. 

5 Supercomputer 

It is an extremely fast computer, 

which can execute hundreds of 
millions of instructions per second. 

PC (Personal Computer) 

 

A PC can be defined as a small, relatively inexpensive computer designed 

for an individual user. PCs are based on the microprocessor technology that 

enables manufacturers to put an entire CPU on one chip. Businesses use 

personal computers for word processing, accounting, desktop publishing, 

and for running spreadsheet and database management applications. At 

home, the most popular use for personal computers is playing games and 

surfing the Internet. 

Although personal computers are designed as single-user systems, these 

systems are normally linked together to form a network. In terms of power, 

now-a-days high-end models of the Macintosh and PC offer the same 

computing power and graphics capability as low-end workstations by Sun 

Microsystems, Hewlett-Packard, and Dell. 
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Workstation 

 

Workstation is a computer used for engineering applications (CAD/CAM), 

desktop publishing, software development, and other such types of 

applications which require a moderate amount of computing power and 

relatively high quality graphics capabilities. 

Workstations generally come with a large, high-resolution graphics screen, 

large amount of RAM, inbuilt network support, and a graphical user 

interface. Most workstations also have mass storage device such as a disk 

drive, but a special type of workstation, called diskless workstation, comes 

without a disk drive. 

Common operating systems for workstations are UNIX and Windows NT. 

Like PC, workstations are also single-user computers like PC but are 

typically linked together to form a local-area network, although they can 

also be used as stand-alone systems. 

Minicomputer 
It is a midsize multi-processing system capable of supporting up to 250 

users simultaneously. 
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Mainframe 
Mainframe is very large in size and is an expensive computer capable of 

supporting hundreds or even thousands of users simultaneously. Mainframe 

executes many programs concurrently and supports many simultaneous 

execution of programs. 
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Supercomputer 
Supercomputers are one of the fastest computers currently available. 

Supercomputers are very expensive and are employed for specialized 

applications that require immense amount of mathematical calculations 

(number crunching). 

 

For example, weather forecasting, scientific simulations, (animated) 

graphics, fluid dynamic calculations, nuclear energy research, electronic 

design, and analysis of geological data (e.g. in petrochemical prospecting). 

  

Components of Computer  
All types of computers follow the same basic logical structure and perform 

the following five basic operations for converting raw input data into 

information useful to their users. 

S.No. Operation Description 

1 Take Input 
The process of entering data and 
instructions into the computer 
system. 
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2 Store Data 

Saving data and instructions so that 

they are available for processing as 
and when required. 

3 
Processing 

Data 

Performing arithmetic, and logical 
operations on data in order to convert 
them into useful information. 

4 
Output 

Information 

The process of producing useful 
information or results for the user, 
such as a printed report or visual 

display. 

5 
Control the 
workflow 

Directs the manner and sequence in 

which all of the above operations are 
performed. 

 

Input Unit 
This unit contains devices with the help of which we enter data into the 

computer. This unit creates a link between the user and the computer. The 

input devices translate the information into a form understandable by the 

computer. 

CPU (Central Processing Unit) 
CPU is considered as the brain of the computer. CPU performs all types of 

data processing operations. It stores data, intermediate results, and 
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instructions (program). It controls the operation of all parts of the 

computer. 

CPU itself has the following three components − 

 ALU (Arithmetic Logic Unit) 

 Memory Unit 

 Control Unit 

Output Unit 
The output unit consists of devices with the help of which we get the 

information from the computer. This unit is a link between the computer 

and the users. Output devices translate the computer's output into a form 

understandable by the users. 

CPU(Central Processing Unit) 
Central Processing Unit (CPU) consists of the following features − 

 CPU is considered as the brain of the computer. 

 CPU performs all types of data processing operations. 

 It stores data, intermediate results, and instructions (program). 

 It controls the operation of all parts of the computer. 

 

CPU itself has following three components. 

 Memory or Storage Unit 

 Control Unit 

 ALU(Arithmetic Logic Unit) 
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Memory or Storage Unit 
This unit can store instructions, data, and intermediate results. This unit 

supplies information to other units of the computer when needed. It is also 

known as internal storage unit or the main memory or the primary storage 

or Random Access Memory (RAM). 

Its size affects speed, power, and capability. Primary memory and 

secondary memory are two types of memories in the computer. Functions 

of the memory unit are − 

 It stores all the data and the instructions required for processing. 

 It stores intermediate results of processing. 

 It stores the final results of processing before these results are released to an 

output device. 

 All inputs and outputs are transmitted through the main memory. 

Control Unit 
This unit controls the operations of all parts of the computer but does not 

carry out any actual data processing operations. 

Functions of this unit are − 
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 It is responsible for controlling the transfer of data and instructions among other 

units of a computer. 

 It manages and coordinates all the units of the computer. 

 It obtains the instructions from the memory, interprets them, and directs the 

operation of the computer. 

 It communicates with Input/Output devices for transfer of data or results from 

storage. 

 It does not process or store data. 

ALU (Arithmetic Logic Unit) 
This unit consists of two subsections namely, 

 Arithmetic Section 

 Logic Section 

Arithmetic Section 

Function of arithmetic section is to perform arithmetic operations like 

addition, subtraction, multiplication, and division. All complex operations 

are done by making repetitive use of the above operations. 

Logic Section 

Function of logic section is to perform logic operations such as comparing, 

selecting, matching, and merging of data. 

Input Devices 
Following are some of the important input devices which are used in a 

computer − 

 Keyboard 

 Mouse 

 Joy Stick 

 Light pen 

 Track Ball 
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 Scanner 

 Graphic Tablet 

 Microphone 

 Magnetic Ink Card Reader(MICR) 

 Optical Character Reader(OCR) 

 Bar Code Reader 

 Optical Mark Reader(OMR) 

Keyboard 
Keyboard is the most common and very popular input device which helps to 

input data to the computer. The layout of the keyboard is like that of 

traditional typewriter, although there are some additional keys provided for 

performing additional functions. 

 

Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards 

with 104 keys or 108 keys are also available for Windows and Internet. 

The keys on the keyboard are as follows − 

S.No Keys & Description 

1 Typing Keys 



32 | P a g e  

 

These keys include the letter keys (A-Z) and digit keys (09) which 

generally give the same layout as that of typewriters. 

2 

Numeric Keypad 

It is used to enter the numeric data or cursor movement. 

Generally, it consists of a set of 17 keys that are laid out in the 

same configuration used by most adding machines and calculators. 

3 

Function Keys 

The twelve function keys are present on the keyboard which are 

arranged in a row at the top of the keyboard. Each function key has 

a unique meaning and is used for some specific purpose. 

4 

Control keys 

These keys provide cursor and screen control. It includes four 

directional arrow keys. Control keys also include Home, End, Insert, 

Delete, Page Up, Page Down, Control(Ctrl), Alternate(Alt), 

Escape(Esc). 

5 

Special Purpose Keys 

Keyboard also contains some special purpose keys such as Enter, 

Shift, Caps Lock, Num Lock, Space bar, Tab, and Print Screen. 

Mouse 
Mouse is the most popular pointing device. It is a very famous cursor-

control device having a small palm size box with a round ball at its base, 

which senses the movement of the mouse and sends corresponding signals 

to the CPU when the mouse buttons are pressed. 

Generally, it has two buttons called the left and the right button and a 

wheel is present between the buttons. A mouse can be used to control the 
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position of the cursor on the screen, but it cannot be used to enter text into 

the computer. 

 

Advantages 

 Easy to use 

 Not very expensive 

 Moves the cursor faster than the arrow keys of the keyboard. 

Joystick 
Joystick is also a pointing device, which is used to move the cursor position 

on a monitor screen. It is a stick having a spherical ball at its both lower 

and upper ends. The lower spherical ball moves in a socket. The joystick 

can be moved in all four directions. 
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The function of the joystick is similar to that of a mouse. It is mainly used in 

Computer Aided Designing (CAD) and playing computer games. 

Light Pen 
Light pen is a pointing device similar to a pen. It is used to select a 

displayed menu item or draw pictures on the monitor screen. It consists of 

a photocell and an optical system placed in a small tube. 

 

When the tip of a light pen is moved over the monitor screen and the pen 

button is pressed, its photocell sensing element detects the screen location 

and sends the corresponding signal to the CPU. 

Track Ball 
Track ball is an input device that is mostly used in notebook or laptop 

computer, instead of a mouse. This is a ball which is half inserted and by 

moving fingers on the ball, the pointer can be moved. 
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Since the whole device is not moved, a track ball requires less space than a 

mouse. A track ball comes in various shapes like a ball, a button, or a 

square. 

Scanner 
Scanner is an input device, which works more like a photocopy machine. It 

is used when some information is available on paper and it is to be 

transferred to the hard disk of the computer for further manipulation. 

 

Scanner captures images from the source which are then converted into a 

digital form that can be stored on the disk. These images can be edited 

before they are printed. 

Digitizer 
Digitizer is an input device which converts analog information into digital 

form. Digitizer can convert a signal from the television or camera into a 

series of numbers that could be stored in a computer. They can be used by 

the computer to create a picture of whatever the camera had been pointed 

at. 
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Digitizer is also known as Tablet or Graphics Tablet as it converts graphics 

and pictorial data into binary inputs. A graphic tablet as digitizer is used for 

fine works of drawing and image manipulation applications. 

Microphone 
Microphone is an input device to input sound that is then stored in a digital 

form. 

 

The microphone is used for various applications such as adding sound to a 

multimedia presentation or for mixing music. 

Magnetic Ink Card Reader (MICR) 
MICR input device is generally used in banks as there are large number of 

cheques to be processed every day. The bank's code number and cheque 
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number are printed on the cheques with a special type of ink that contains 

particles of magnetic material that are machine readable. 

 

This reading process is called Magnetic Ink Character Recognition (MICR). 

The main advantages of MICR is that it is fast and less error prone. 

Optical Character Reader (OCR) 
OCR is an input device used to read a printed text. 

 

OCR scans the text optically, character by character, converts them into a 

machine readable code, and stores the text on the system memory. 
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Bar Code Readers 
Bar Code Reader is a device used for reading bar coded data (data in the 

form of light and dark lines). Bar coded data is generally used in labelling 

goods, numbering the books, etc. It may be a handheld scanner or may be 

embedded in a stationary scanner. 

 

Bar Code Reader scans a bar code image, converts it into an alphanumeric 

value, which is then fed to the computer that the bar code reader is 

connected to. 

Optical Mark Reader (OMR) 
OMR is a special type of optical scanner used to recognize the type of mark 

made by pen or pencil. It is used where one out of a few alternatives is to 

be selected and marked. 
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It is specially used for checking the answer sheets of examinations having 

multiple choice questions. 

 Output Devices 
Following are some of the important output devices used in a computer. 

 Monitors 

 Graphic Plotter 

 Printer 

Monitors 
Monitors, commonly called as Visual Display Unit (VDU), are the main 

output device of a computer. It forms images from tiny dots, called pixels 

that are arranged in a rectangular form. The sharpness of the image 

depends upon the number of pixels. 

There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 

Cathode-Ray Tube (CRT) Monitor 

The CRT display is made up of small picture elements called pixels. The 

smaller the pixels, the better the image clarity or resolution. It takes more 

than one illuminated pixel to form a whole character, such as the letter ‘e’ 

in the word help. 
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A finite number of characters can be displayed on a screen at once. The 

screen can be divided into a series of character boxes - fixed location on the 

screen where a standard character can be placed. Most screens are capable 

of displaying 80 characters of data horizontally and 25 lines vertically. 

There are some disadvantages of CRT − 

 Large in Size 

 High power consumption 

Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices that have reduced 

volume, weight and power requirement in comparison to the CRT. You can 

hang them on walls or wear them on your wrists. Current uses of flat-panel 

displays include calculators, video games, monitors, laptop computer, and 

graphics display. 
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The flat-panel display is divided into two categories − 

 Emissive Displays − Emissive displays are devices that convert electrical 

energy into light. For example, plasma panel and LED (Light-Emitting Diodes). 

 Non-Emissive Displays − Non-emissive displays use optical effects to convert 

sunlight or light from some other source into graphics patterns. For example, 

LCD (Liquid-Crystal Device). 

Printers 
Printer is an output device, which is used to print information on paper. 

There are two types of printers − 

 Impact Printers 

 Non-Impact Printers 

Impact Printers 

Impact printers print the characters by striking them on the ribbon, which is 

then pressed on the paper. 

Characteristics of Impact Printers are the following − 

 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 
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 There is physical contact with the paper to produce an image 

These printers are of two types − 

 Character printers 

 Line printers 

Character Printers 

Character printers are the printers which print one character at a time. 

These are further divided into two types: 

 Dot Matrix Printer(DMP) 

 Daisy Wheel 

Dot Matrix Printer 

In the market, one of the most popular printers is Dot Matrix Printer. These 

printers are popular because of their ease of printing and economical price. 

Each character printed is in the form of pattern of dots and head consists of 

a Matrix of Pins of size (5*7, 7*9, 9*7 or 9*9) which come out to form a 

character which is why it is called Dot Matrix Printer. 

 

Advantages 

 Inexpensive 
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 Widely Used 

 Other language characters can be printed 

Disadvantages 

 Slow Speed 

 Poor Quality 

Daisy Wheel 

Head is lying on a wheel and pins corresponding to characters are like 

petals of Daisy (flower) which is why it is called Daisy Wheel Printer. These 

printers are generally used for word-processing in offices that require a few 

letters to be sent here and there with very nice quality. 

 

Advantages 

 More reliable than DMP 

 Better quality 

 Fonts of character can be easily changed 

Disadvantages 

 Slower than DMP 

 Noisy 

 More expensive than DMP 

Line Printers 
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Line printers are the printers which print one line at a time. 

 

These are of two types − 

 Drum Printer 

 Chain Printer 

Drum Printer 

This printer is like a drum in shape hence it is called drum printer. The 

surface of the drum is divided into a number of tracks. Total tracks are 

equal to the size of the paper, i.e. for a paper width of 132 characters, 

drum will have 132 tracks. A character set is embossed on the track. 

Different character sets available in the market are 48 character set, 64 and 

96 characters set. One rotation of drum prints one line. Drum printers are 

fast in speed and can print 300 to 2000 lines per minute. 

Advantages 

 Very high speed 

Disadvantages 

 Very expensive 

 Characters fonts cannot be changed 

Chain Printer 
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In this printer, a chain of character sets is used, hence it is called Chain 

Printer. A standard character set may have 48, 64, or 96 characters. 

Advantages 

 Character fonts can easily be changed. 

 Different languages can be used with the same printer. 

Disadvantages 

 Noisy 

Non-impact Printers 

Non-impact printers print the characters without using the ribbon. These 

printers print a complete page at a time, thus they are also called as Page 

Printers. 

These printers are of two types − 

 Laser Printers 

 Inkjet Printers 

Characteristics of Non-impact Printers 

 Faster than impact printers 

 They are not noisy 

 High quality 

 Supports many fonts and different character size 

Laser Printers 

These are non-impact page printers. They use laser lights to produce the 

dots needed to form the characters to be printed on a page. 
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Advantages 

 Very high speed 

 Very high quality output 

 Good graphics quality 

 Supports many fonts and different character size 

Disadvantages 

 Expensive 

 Cannot be used to produce multiple copies of a document in a single printing 

Inkjet Printers 

Inkjet printers are non-impact character printers based on a relatively new 

technology. They print characters by spraying small drops of ink onto 

paper. Inkjet printers produce high quality output with presentable 

features. 
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They make less noise because no hammering is done and these have many 

styles of printing modes available. Color printing is also possible. Some 

models of Inkjet printers can produce multiple copies of printing also. 

Advantages 

 High quality printing 

 More reliable 

Disadvantages 

 Expensive as the cost per page is high 

 Slow as compared to laser printer 

Computer - Memory 
A memory is just like a human brain. It is used to store data and 

instructions. Computer memory is the storage space in the computer, 

where data is to be processed and instructions required for processing are 

stored. The memory is divided into large number of small parts called cells. 

Each location or cell has a unique address, which varies from zero to 

memory size minus one. For example, if the computer has 64k words, then 

this memory unit has 64 * 1024 = 65536 memory locations. The address of 

these locations varies from 0 to 65535. 



48 | P a g e  

 

Memory is primarily of three types − 

 Cache Memory 

 Primary Memory/Main Memory 

 Secondary Memory 

Cache Memory 
Cache memory is a very high speed semiconductor memory which can 

speed up the CPU. It acts as a buffer between the CPU and the main 

memory. It is used to hold those parts of data and program which are most 

frequently used by the CPU. The parts of data and programs are transferred 

from the disk to cache memory by the operating system, from where the 

CPU can access them. 

 

Advantages 

The advantages of cache memory are as follows − 

 Cache memory is faster than main memory. 

 It consumes less access time as compared to main memory. 

 It stores the program that can be executed within a short period of time. 
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 It stores data for temporary use. 

Disadvantages 

The disadvantages of cache memory are as follows − 

 Cache memory has limited capacity. 

 It is very expensive. 

Primary Memory (Main Memory) 
Primary memory holds only those data and instructions on which the 

computer is currently working. It has a limited capacity and data is lost 

when power is switched off. It is generally made up of semiconductor 

device. These memories are not as fast as registers. The data and 

instruction required to be processed resides in the main memory. It is 

divided into two subcategories RAM and ROM. 

 

Characteristics of Main Memory 

 These are semiconductor memories. 

 It is known as the main memory. 

 Usually volatile memory. 

 Data is lost in case power is switched off. 

 It is the working memory of the computer. 
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 Faster than secondary memories. 

 A computer cannot run without the primary memory. 

Secondary Memory 
This type of memory is also known as external memory or non-volatile. It is 

slower than the main memory. These are used for storing data/information 

permanently. CPU directly does not access these memories, instead they 

are accessed via input-output routines. The contents of secondary 

memories are first transferred to the main memory, and then the CPU can 

access it. For example, disk, CD-ROM, DVD, etc. 

 

Characteristics of Secondary Memory 

 These are magnetic and optical memories. 

 It is known as the backup memory. 

 It is a non-volatile memory. 

 Data is permanently stored even if power is switched off. 

 It is used for storage of data in a computer. 

 Computer may run without the secondary memory. 

 Slower than primary memories. 

Random Access Memory 
RAM (Random Access Memory) is the internal memory of the CPU for 

storing data, program, and program result. It is a read/write memory which 
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stores data until the machine is working. As soon as the machine is 

switched off, data is erased. 

 

Access time in RAM is independent of the address, that is, each storage 

location inside the memory is as easy to reach as other locations and takes 

the same amount of time. Data in the RAM can be accessed randomly but it 

is very expensive. 

RAM is volatile, i.e. data stored in it is lost when we switch off the computer 

or if there is a power failure. Hence, a backup Uninterruptible Power System 

(UPS) is often used with computers. RAM is small, both in terms of its 

physical size and in the amount of data it can hold. 

RAM is of two types − 

 Static RAM (SRAM) 

 Dynamic RAM (DRAM) 

Static RAM (SRAM) 
The word static indicates that the memory retains its contents as long as 

power is being supplied. However, data is lost when the power gets down 

due to volatile nature. SRAM chips use a matrix of 6-transistors and no 

capacitors. Transistors do not require power to prevent leakage, so SRAM 

need not be refreshed on a regular basis. 
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There is extra space in the matrix, hence SRAM uses more chips than DRAM 

for the same amount of storage space, making the manufacturing costs 

higher. SRAM is thus used as cache memory and has very fast access. 

Characteristic of Static RAM 

 Long life 

 No need to refresh 

 Faster 

 Used as cache memory 

 Large size 

 Expensive 

 High power consumption 

Dynamic RAM (DRAM) 
DRAM, unlike SRAM, must be continually refreshed in order to maintain 

the data. This is done by placing the memory on a refresh circuit that 

rewrites the data several hundred times per second. DRAM is used for most 

system memory as it is cheap and small. All DRAMs are made up of 

memory cells, which are composed of one capacitor and one transistor. 

Characteristics of Dynamic RAM 

 Short data lifetime 

 Needs to be refreshed continuously 

 Slower as compared to SRAM 

 Used as RAM 

 Smaller in size 

 Less expensive 

 Less power consumption 

Read Only Memory 
ROM stands for Read Only Memory. The memory from which we can only 

read but cannot write on it. This type of memory is non-volatile. The 
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information is stored permanently in such memories during manufacture. A 

ROM stores such instructions that are required to start a computer. This 

operation is referred to as bootstrap. ROM chips are not only used in the 

computer but also in other electronic items like washing machine and 

microwave oven. 

 

Let us now discuss the various types of ROMs and their characteristics. 

MROM (Masked ROM) 
The very first ROMs were hard-wired devices that contained a pre-

programmed set of data or instructions. These kind of ROMs are known as 

masked ROMs, which are inexpensive. 

PROM (Programmable Read Only Memory) 
PROM is read-only memory that can be modified only once by a user. The 

user buys a blank PROM and enters the desired contents using a PROM 

program. Inside the PROM chip, there are small fuses which are burnt open 

during programming. It can be programmed only once and is not erasable. 
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EPROM (Erasable and Programmable Read 

Only Memory) 
EPROM can be erased by exposing it to ultra-violet light for a duration of up 

to 40 minutes. Usually, an EPROM eraser achieves this function. During 

programming, an electrical charge is trapped in an insulated gate region. 

The charge is retained for more than 10 years because the charge has no 

leakage path. For erasing this charge, ultra-violet light is passed through a 

quartz crystal window (lid). This exposure to ultra-violet light dissipates the 

charge. During normal use, the quartz lid is sealed with a sticker. 

EEPROM (Electrically Erasable and 

Programmable Read Only Memory) 
EEPROM is programmed and erased electrically. It can be erased and 

reprogrammed about ten thousand times. Both erasing and programming 

take about 4 to 10 ms (millisecond). In EEPROM, any location can be 

selectively erased and programmed. EEPROMs can be erased one byte at a 

time, rather than erasing the entire chip. Hence, the process of 

reprogramming is flexible but slow. 

Advantages of ROM 
The advantages of ROM are as follows − 

 Non-volatile in nature 

 Cannot be accidentally changed 

 Cheaper than RAMs 

 Easy to test 

 More reliable than RAMs 

 Static and do not require refreshing 

 Contents are always known and can be verified 

Computer - Motherboard 
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The motherboard serves as a single platform to connect all of the parts of a 

computer together. It connects the CPU, memory, hard drives, optical 

drives, video card, sound card, and other ports and expansion cards directly 

or via cables. It can be considered as the backbone of a computer. 

 

Features of Motherboard 
A motherboard comes with following features − 

 Motherboard varies greatly in supporting various types of components. 

 Motherboard supports a single type of CPU and few types of memories. 

 Video cards, hard disks, sound cards have to be compatible with the 

motherboard to function properly. 

 Motherboards, cases, and power supplies must be compatible to work properly 

together. 

Popular Manufacturers 
Following are the popular manufacturers of the motherboard. 

 Intel 

 ASUS 
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 AOpen 

 ABIT 

 Biostar 

 Gigabyte 

 MSI 

Description of Motherboard 
The motherboard is mounted inside the case and is securely attached via 

small screws through pre-drilled holes. Motherboard contains ports to 

connect all of the internal components. It provides a single socket for CPU, 

whereas for memory, normally one or more slots are available. 

Motherboards provide ports to attach the floppy drive, hard drive, and 

optical drives via ribbon cables. Motherboard carries fans and a special port 

designed for power supply. 

There is a peripheral card slot in front of the motherboard using which video 

cards, sound cards, and other expansion cards can be connected to the 

motherboard. 

On the left side, motherboards carry a number of ports to connect the 

monitor, printer, mouse, keyboard, speaker, and network cables. 

Motherboards also provide USB ports, which allow compatible devices to be 

connected in plug-in/plug-out fashion. For example, pen drive, digital 

cameras, etc. 

Memory Units 
Memory unit is the amount of data that can be stored in the storage unit. 

This storage capacity is expressed in terms of Bytes. 

The following table explains the main memory storage units − 

S.No. Unit & Description 

1 Bit (Binary Digit) 

A binary digit is logical 0 and 1 representing a passive or an active state 
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of a component in an electric circuit. 

2 

Nibble 

A group of 4 bits is called nibble. 

3 

Byte 

A group of 8 bits is called byte. A byte is the smallest unit, which can 

represent a data item or a character. 

4 

Word 

A computer word, like a byte, is a group of fixed number of bits 

processed as a unit, which varies from computer to computer but is fixed 

for each computer. 

The length of a computer word is called word-size or word length. It may 

be as small as 8 bits or may be as long as 96 bits. A computer stores the 

information in the form of computer words. 

The following table lists some higher storage units − 

S.No. Unit & Description 

1 
Kilobyte (KB) 

1 KB = 1024 Bytes 

2 

Megabyte (MB) 

1 MB = 1024 KB 

3 

GigaByte (GB) 

1 GB = 1024 MB 
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4 

TeraByte (TB) 

1 TB = 1024 GB 

5 

PetaByte (PB) 

1 PB = 1024 TB 

Ports 
A port is a physical docking point using which an external device can be 

connected to the computer. It can also be programmatic docking point 

through which information flows from a program to the computer or over 

the Internet. 

Characteristics of Ports 
A port has the following characteristics − 

 External devices are connected to a computer using cables and ports. 

 Ports are slots on the motherboard into which a cable of external device is 

plugged in. 

 Examples of external devices attached via ports are the mouse, keyboard, 

monitor, microphone, speakers, etc. 
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Let us now discuss a few important types of ports − 

Serial Port 
 Used for external modems and older computer mouse 

 Two versions: 9 pin, 25 pin model 

 Data travels at 115 kilobits per second 

Parallel Port 
 Used for scanners and printers 

 Also called printer port 

 25 pin model 

 IEEE 1284-compliant Centronics port 

PS/2 Port 
 Used for old computer keyboard and mouse 

 Also called mouse port 
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 Most of the old computers provide two PS/2 port, each for the mouse and 

keyboard 

 IEEE 1284-compliant Centronics port 

Universal Serial Bus (or USB) Port 
 It can connect all kinds of external USB devices such as external hard disk, 

printer, scanner, mouse, keyboard, etc. 

 It was introduced in 1997. 

 Most of the computers provide two USB ports as minimum. 

 Data travels at 12 megabits per seconds. 

 USB compliant devices can get power from a USB port. 

VGA Port 
 Connects monitor to a computer's video card. 

 It has 15 holes. 

 Similar to the serial port connector. However, serial port connector has pins, 

VGA port has holes. 

Power Connector 
 Three-pronged plug. 

 Connects to the computer's power cable that plugs into a power bar or wall 

socket. 

Firewire Port 
 Transfers large amount of data at very fast speed. 

 Connects camcorders and video equipment to the computer. 

 Data travels at 400 to 800 megabits per seconds. 

 Invented by Apple. 

 It has three variants: 4-Pin FireWire 400 connector, 6-Pin FireWire 400 

connector, and 9-Pin FireWire 800 connector. 
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Modem Port 

 Connects a PC's modem to the telephone network. 

Ethernet Port 
 Connects to a network and high speed Internet. 

 Connects the network cable to a computer. 

 This port resides on an Ethernet Card. 

 Data travels at 10 megabits to 1000 megabits per seconds depending upon the 

network bandwidth. 

Game Port 
 Connect a joystick to a PC 

 Now replaced by USB 

Digital Video Interface, DVI port 
 Connects Flat panel LCD monitor to the computer's high-end video graphic 

cards. 

 Very popular among video card manufacturers. 

Sockets 
 Sockets connect the microphone and speakers to the sound card of the 

computer. 

Computer - Hardware 
Hardware represents the physical and tangible components of a computer, 

i.e. the components that can be seen and touched. 

Examples of Hardware are the following − 

 Input devices − keyboard, mouse, etc. 

 Output devices − printer, monitor, etc. 

 Secondary storage devices − Hard disk, CD, DVD, etc. 
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 Internal components − CPU, motherboard, RAM, etc. 

 

Relationship between Hardware and 
Software 

 Hardware and software are mutually dependent on each other. Both of them 

must work together to make a computer produce a useful output. 

 Software cannot be utilized without supporting hardware. 

 Hardware without a set of programs to operate upon cannot be utilized and is 

useless. 

 To get a particular job done on the computer, relevant software should be 

loaded into the hardware. 

 Hardware is a one-time expense. 

 Software development is very expensive and is a continuing expense. 

 Different software applications can be loaded on a hardware to run different 

jobs. 

 A software acts as an interface between the user and the hardware. 
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 If the hardware is the 'heart' of a computer system, then the software is its 

'soul'. Both are complementary to each other. 

Computer - Software 
Software is a set of programs, which is designed to perform a well-defined 

function. A program is a sequence of instructions written to solve a 

particular problem. 

There are two types of software − 

 System Software 

 Application Software 

System Software 
The system software is a collection of programs designed to operate, 

control, and extend the processing capabilities of the computer itself. 

System software is generally prepared by the computer manufacturers. 

These software products comprise of programs written in low-level 

languages, which interact with the hardware at a very basic level. System 

software serves as the interface between the hardware and the end users. 

Some examples of system software are Operating System, Compilers, 

Interpreter, Assemblers, etc. 

 

Here is a list of some of the most prominent features of a system software 

− 

 Close to the system 

 Fast in speed 

 Difficult to design 
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 Difficult to understand 

 Less interactive 

 Smaller in size 

 Difficult to manipulate 

 Generally written in low-level language 

Application Software 
Application software products are designed to satisfy a particular need of a 

particular environment. All software applications prepared in the computer 

lab can come under the category of Application software. 

Application software may consist of a single program, such as Microsoft's 

notepad for writing and editing a simple text. It may also consist of a 

collection of programs, often called a software package, which work 

together to accomplish a task, such as a spreadsheet package. 

Examples of Application software are the following − 

 Payroll Software 

 Student Record Software 

 Inventory Management Software 

 Income Tax Software 

 Railways Reservation Software 

 Microsoft Office Suite Software 

 Microsoft Word 

 Microsoft Excel 

 Microsoft PowerPoint 

 

Features of application software are as follows − 
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 Close to the user 

 Easy to design 

 More interactive 

 Slow in speed 

 Generally written in high-level language 

 Easy to understand 

 Easy to manipulate and use 

 Bigger in size and requires large storage space 

 Operating System 
The Operating System is a program with the following features − 

 An operating system is a program that acts as an interface between the 

software and the computer hardware. 

 It is an integrated set of specialized programs used to manage overall resources 

and operations of the computer. 

 It is a specialized software that controls and monitors the execution of all other 

programs that reside in the computer, including application programs and other 

system software. 
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Objectives of Operating System 
The objectives of the operating system are − 

 To make the computer system convenient to use in an efficient manner. 

 To hide the details of the hardware resources from the users. 

 To provide users a convenient interface to use the computer system. 

 To act as an intermediary between the hardware and its users, making it easier 

for the users to access and use other resources. 

 To manage the resources of a computer system. 

 To keep track of who is using which resource, granting resource requests, and 

mediating conflicting requests from different programs and users. 

 To provide efficient and fair sharing of resources among users and programs. 
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Characteristics of Operating System 
Here is a list of some of the most prominent characteristic features of 

Operating Systems − 

 Memory Management − Keeps track of the primary memory, i.e. what part of 

it is in use by whom, what part is not in use, etc. and allocates the memory 

when a process or program requests it. 

 Processor Management − Allocates the processor (CPU) to a process and 

deallocates the processor when it is no longer required. 

 Device Management − Keeps track of all the devices. This is also called I/O 

controller that decides which process gets the device, when, and for how much 

time. 

 File Management − Allocates and de-allocates the resources and decides who 

gets the resources. 

 Security − Prevents unauthorized access to programs and data by means of 

passwords and other similar techniques. 

 Job Accounting − Keeps track of time and resources used by various jobs 

and/or users. 

 Control Over System Performance − Records delays between the request for 

a service and from the system. 

 Interaction with the Operators − Interaction may take place via the console 

of the computer in the form of instructions. The Operating System 

acknowledges the same, does the corresponding action, and informs the 

operation by a display screen. 

 Error-detecting Aids − Production of dumps, traces, error messages, and 

other debugging and error-detecting methods. 

 Coordination Between Other Software and Users − Coordination and 

assignment of compilers, interpreters, assemblers, and other software to the 

various users of the computer systems. 
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Disk Operating System – MS Dos 

Commands 

What is Operating System? 

Here, you will find the set of DOS commands, with the help of them, you can 

work with MS DOS. Operating system is the interface b/w user and h/w. it is the 

most commonly used system software, it manages the basic operation of a 

computer. These operations include booting the computer, Manage of all 

computer resources (all H/w parts). 

Thus we can define an O.S. as a master system of programs that manages the 

overall operations of the computer. O.S. Can be divided into two categories on 

the basis of the number of users at a time, as follows:-  

1. Single User O.S.  

2. Multi User O.S. 

 

Single User O.S.: 

In this case, only one user can work on computer at a time. These O.S. are 

suitable for personal computers. Used at homes. 

Eg. Windows Xp, Windows 98, Ms- DOS etc 

Multi User O.S.: 

In Multi User O.S. Environment many users can work on the computer at a time. 

These are suitable for organizations and educational institutions. 

Eg. Windows 2000, Windows NT, Linux, Unix 

 

Operating system as a User Interface:- 

There are mainly two types of O.S. as a user interface, these are following: 

· Graphical User Interface (GUI) 

· Command User Interface (CUI) 

Graphical User Interface:- 

The GUI allows the user to select the desired option with the help of graphical 

images. This type of interface uses both images and menu to select commands ar 

initiate different operations. Generally these graphical images are called Icons, 

which are small pictorial figures representing different tasks, Procedures and 

programs. 
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Command User Interface:- CUI can help the user to interact or communicate 

with the computer through different commands. In this type of Interface the user 

has to memorize so many commands or to refer book for different commands. It 

also takes time to type each commands. 

What is MS DOS (Microsoft Disk Operating 

System)? 

DOS stands for DISK OPERATING SYSTEM It is one of the most commonly used 

O.S. in a single user environment. It runs mainly on personal computers made by 

different companies, such as Compaq, IBM, HP.  

There are two O.S. referred as DOS. 

1.) MS DOS (Microsoft Disk Operating System) 

2.) PC DOS (Personal Computer Disk Operating System) 

List of all DOS Commands. 

1) Date Command 

This command is used to change or/and display current system date. 

C:\>DATE /t 

Sun 03/04/2012 

 

C:\>DATE 

The current date is: Sun 03/04/2012 

Enter the new date: (mm-dd-yy) 04-05-2013 

 

2) TIME Command 

This command is used to change or/and display current system time. 

C:\>TIME /t 

02:48 AM 

 

C:\>TIME 

The current time is:  2:48:47.32 

Enter the new time: 06:10:00 



70 | P a g e  

 

 

3) VER Command 

This command is used to display the window's version. 

C:\>ver 

Microsoft Windows [Version 6.1.7600] 

 

4) VOL Command 

This command is used to display the disk volume level or serial number. 

C:\>vol d: 

Volume in drive D is SOFTWARE 

Volume Serial Number is 147C-DA89 

 

5) LABEL Command 

This command is used to create, update and delete the serial number of 

particular disk. 

C:\>LABEL D: 

Volume in drive D: is SOFTWARE 

Volume Serial Number is 147C-DA89 

Volume label (32 characters, ENTER for none)? IMP_DOCUMENTS 

 

6) ECHO Command 

This command is used to display message on command screen, and also turn 

on/off command-echoing. 

Command syntax is :  

C:\> ECHO [ON|OFF] 

C:\> ECHO [MESSAGE] 

 

C:\>ECHO "https://www.includehelp.com" 

"https://www.includehelp.com" 

 

C:\>ECHO OFF 
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DATE/T 

Sun 03/04/2012 

 

ECHO ON 

C:\> 

 

7) PROMPT Command 

This command is used to change the command prompt. 

Switches: 

    $A - & (Ampersand)  

    $B  - | (pipe)  

    $C - ( (Left parenthesis)  

    $D - Current date  

    $E  - Escape code (ASCII code 27)  

    $F - ) (Right parenthesis)  

    $G - > (greater-than sign)  

    $H - Backspace (erases previous character)  

    $L - < (less-than sign)  

    $N - Current drive  

    $P - Current drive and path  

    $Q - = (equal sign)  

    $S  - (space)  

    $T - Current time  

    $$ - $ dollar sign  

C:\>prompt "includehelp.com" 

 

"includehelp.com"DATE/t 

Sun 03/04/2012 

 

"includehelp.com"PROMPT $p$g 

 

C:\> 

 

8) TITLE Command 

This command is used to change the title of MS DOS screen. 
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C:\>TITLE includehelp.com 

 

9) MKDIR/MD Command 

MKDIR/MD command is used to create directory in particular drive. 

Command syntax is : 

C:\> MKDIR [drive]:\[Directory_Name] 

C:\> MKDIR [Directory_Name] 

* If you do not enter path [drive or directory], 

directory will make in current working drive/directory. 

 

1. C:\>MKDIR D:\Tutorial 

2. C:\>MKDIR Tutorial 

3. C:\>MKDIR D:\Folder1\Folder2\Folder3 

 

Explanation 

1. Directory will create into D: drive  

2. Directory will create into C: drive. 

3. You can also create directories using sub-direcories, here 3 directories will be 

created . Folder1 will be created in D: drive then Folder2 will be in Folder1 and 

Folder3 will be in Folder2. 

10) CHDIR/CD Command 

CHDIR/CD command is used to change current working direcory. 

Command syntax is : 

C:\> CHDIR [drive]:\[Directory_Name] 

C:\> CHDIR [Directory_Name] 

 

11) CD.. and CD\ Command 

CD.. command is used to exit from current working directory. 

CD\ command is used to exit from all directories and reaches to current drive. 

Command syntax is : 
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[Current_working_drive\direcotries..\> CD.. 

[Current_working_drive\direcotries..\> CD\            

 

1. C:\>d: 

2. d:\>cd tutorial 

3. d:\Tutorial>cd.. 

4. d:\>cd folder1\folder2\folder3 

5. d:\Folder1\Folder2\Folder3>cd\ 

6. d:\>cd folder1\folder2 

7. d:\Folder1\Folder2>cd\ 

8. d:\> 

Explanation 

1: Change current drive C: to D: drive. 

2: Open tutorial directory . 

3: Current working dir. is"D:\tutorial> ", CD.. - exit from tutorial directory. 

4: Open folder3 directory. (folder3 exits in "D:\folder1\folder2" No need to write 

D:\ because current working directory is D:). 

5: Current working directory is "folder3". CD\ - exit from all directories. 

6: Open folder2 directory .(folder2 is exists in "D:\folder1"). 

7: Current working directory is "folder2". CD\ - exit from all directories. 

12) COPY CON 

COPY CON command is used to create a text file. 

Command syntax is : 

C:\>COPY CON [file_name] 

Your text will goes here.... 

^Z (CTRL+Z) OR F6 .. (to save file)           

 

C:\>COPY CON about_us.txt 

includehelp.com provides online tutorials . 

^Z 

C:\> 

 

13) TYPE Command 

TYPE command is used to display file. 
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Command syntax is : 

C:\> TYPE [FILE_PATH]        

 

C:\>TYPE about_us.txt 

includehelp.com provides online tutorials . 

C:\> 

 

14) EDIT Command 

EDIT command is used to open DOS Editor to create,display, modify files. 

Switches 

/B - To open black and white mode. 

/R - To open file in read only mode. 

Command syntax is :  

 

C:\>EDIT [/B|/R] [FILE_PATH]       

 

1. C:\>Edit 

2. C:\>Edit/B about_us.txt 

3. C:\>Edit/R about_us.txt 

4. C:\>Edit about_us.txt 

 

Explanation 

1: Opens DOS Editor. 

2: Opens about_us.txt file in black and white dos editor. 

3: Opens about_us.txt file in read only mode. 

4: Open about_us.txt file in colored screen. 

15) DIR Command 

DIR command is used to displays a list of files and subdirectories in a directory. 

Switches 

/A  Attribute wise filtering .. 

        R : Read only files. 

        D : Directories only. 
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        H : Hidden items only. 

        S : System files only. 

        -D: Files only   

/B  Uses bare format (no heading information or summary).    

/C  Display the thousand separator in file sizes. This is 

the default.  

    Use /-C to disable display of separator.    

/D  Same as wide but files are list sorted by column.    

/L  Uses lowercase.    

/N  New long list format where filenames are on the far 

right.    

/O  List by files in sorted order.)  

        S: Size wise sorting. 

        N: Name wise. 

        D: Date wise. 

        E: Extension wise sorting. 

                       

/P  Pauses after each screenful of information.    

/Q  Display the owner of the file.    

/S  Displays files in specified directory and all 

subdirectories.    

/T  Control what time field displayed or used for sorting    

timefield    C Creation,  

A Last Access,  

W Last Written   

/W  Uses wide list format.    

 

Command syntax is :  

DIR [drive:][path][filename] [/A[[:]attributes]] [/B] [/C] [/D] [/L]... 

    1)  C:\> DIR D: 

        (display all directories and files of d: drive). 

    2)  Using "A" attribute:- 

        C:\> DIR/AD D: 

        (display direcotries (folders) only of d: drive). 

        C:\> DIR/A-D D: 

        (display only files of d: drive). 

        C:\> DIR/AH D: 

        (display all hidden items of d: drive). 

    3)  C:\> DIR/A-D/AR D: 

        (display all files(only) with read only property). 
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Using wild characters: 

1) To find all .txt (text) file from d:\folder1  

C:\>DIR D:\folder1\*.txt 

2) To display all .docx (ms word files) starting with "A" filename. 

C:\>DIR D:\folder1\A*.docx 

3) To display all files of E: drive starting with "A" but third charcter of file 

name must be "C" (of any type/extension). 

C:\>DIR D:\A?C*.*  

4) To display all files with all extenstions of E:\. 

C:\>DIR E:\*.*  
 

16) TREE Command 

This command is used to display files and sub directories of particular directory. 

Switches 

F : Displays the name of the files in each folder. 

A : Use ASCII instead of extended characters. 

Command syntax is :  

 

C:\>TREE/[SWITCH] [DRIVE:]\[DIRECTORY]      

                  

C:\>TREE D:\test 

Folder PATH listing for volume iHelp's  Personal Data 

Volume serial number is 00000002 147C:DA89 

D:\TEST 

├───folder1 

├───folder2 

│   └───SubFolder1 

│       ├───SubFolderA 

│       └───SubFolderB 

└───folder3 

 

C:\> 
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C:\>TREE/F D:\test 

Folder PATH listing for volume iHelp's  Personal Data 

Volume serial number is 00000002 147C:DA89 

D:\TEST 

│   file1.txt 

│   file2.txt 

│ 

├───folder1 

├───folder2 

│   │   file-A.txt 

│   │   file-B.txt 

│   │ 

│   └───SubFolder1 

│       │   t.txt 

│       │ 

│       ├───SubFolderA 

│       └───SubFolderB 

└───folder3 

 

C:\> 

 

17) DEL/ERASE Command 

DEL/ERASE command is used to delete one or more than one file at a time. 

Command syntax is : 

C:\> Del [/Switch] [File Path]  

 

Following switches can be use with this command. 

1. /P : Display the confirmation message. 

2. /F : Force deleting of read only files. 

3. /A : Select file to delete based on attributes : 

o S : System files 

o R : read only files 

o H : Hidden files 

o A : ready for archiving 

C:\>ERASE/P D:\includehelp.txt 
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D:\includehelp.txt, Delete (Y/N)? y 

 

Explanation : above command will delete includehelp.txt file from D:\ drive, with 

confirmation message "D:\includehelp.txt, Delete (Y/N) ? " Press Y to delete.. 

1) C:\> Del MyFile.Txt  

2) C:\> Del/AH *.jpg 

3) C:\> Del D:\Ram\Shyam\F1.Doc 

 

Explanation 

1) Delete MyFile.txt from C drive.  

2) Delete all hidden files with extension .jpg( JPEG image files). 

3) Delete F1.Doc from D:\Ram\Shyam folder.. 

18) RM/RMDIR Command 

This command is used to removes (deletes) a directory (folder). 

Command syntax is : 

C:\> RD [/Switch] [Path]  

Following switches can be use with this command. 

 /S : Removes all directories and files in the specified directory in addition to 

the directory itself. Used to remove a directory tree. 

 /Q : Quiet mode, do not ask if ok to remove a directory tree with /S. 

1. C:\>TREE d:\examples 

2. Folder PATH listing for volume Mike's  Personal Data 

3. Volume serial number is 00000002 147C:DA89 

4. D:\EXAMPLES 

5. ├───include 

6. │   └───Debug 

7. └───loop_Ex 

 

8. C:\>RD/S d:\examples 

9. d:\examples, Are you sure (Y/N)? y 
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10. C:\> 

 

Explanation 

1. Command to display d:\examples directory. 

8. Command to delete d:\examples directory. 

9. Confirmation message to delete ...  

19) SHUTDOWN Command 

Shutdown command is used to shuts down the window. 

Switches 

/S Shuts down the window. /F Forcely shut down the window. /C Display dialog 

with comment and then shutdown. /T Shutdown time in XX seconds. /A Abort the 

shutdown command. /I To displai GUI window for remote shutdown. 

1) C:\> SHUTDOWN -S 

2) C:\> SHUTDOWN -F 

3) C:\> SHUTDOWN -S -C "Windows is shutting down due to 

virus.." 

4) C:\> SHUTDOWN -S -T 30 

5) C:\> SHUTDOWN -A 

6) C:\> SHUTDOWN -I 

What is BOOTing ? 

When the computer is switched on, the firmware program in Read Only 

Memory(ROM) also called Basic Input-Output System(BIOS) reads programs and 

data i.e. Operating System and loads it into memory (RAM). This process is known 

Bootstrapping(Booting). The OS once loaded takes control of the computer, handles 

user interaction and executes application programs. 

 Booting Sequence 

During Booting process, computer loads the operating system into its memory. DOS 

booting involves reading following files into memory namely IO.SYS, MSDOS.SYS, 

and COMMAND COM. The Basic Input/Output Program (IO.SYS): This program 
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provides interface between the hardware devices and software of the system. It takes 

care of the keyboard input, character output to monitor, output to printer and time of 

the day. The File and Disk Manager Program (MSDOS.SYS) : It contains the file 

management and the disk buffering management capabilities. It keeps track of all the 

disk access of an application program and remains permanently in memory. The 

Command Processor (COMMAND.COM) : It is also called command interpreter. It is 

the program that displays the system prompt and handles user interface by executing 

the command typed in by the user using keyboard. 

The CONFIG.SYS file : This file contains reference to device drivers which are 

loaded when OS takes control of the computer. This device drivers are required for 

configuring operating system for running special devices. 

The AUTOEXEC.BAT file : This is a special batch program that is automatically 

executed when the system is started. It can be used to define keys, define the path that 

MS-DOS uses to find files, display messages on the screen etc. It will be executed 

only if it exists in the root directory or the diskette from which the system is loaded. 

Each time the system is started, MS-DOS executes the commands stored in 

AUTOEXEC.BAT file. One can run it without restarting the system by typing 

AUTOEXEC at the command prompt. 

 Disk/Drives : 

The user can store data or programs on secondary storage devices called Hard disk or 

Floppy disk. Physically disks store data by recording any pattern of magnetic changes 

on using a tiny read-write head that moves over the surface. Disk is divided into 

sectors and tracks. The first two characters of alphabet (a: or b:) are reserved for 

Floppy disks, Hard disks are identified by characters (c:) or (d:), the next character in 

the sequence is assigned to Compact Disk (CD-ROM) drive further the network drives 

connected to the system are assigned the remaining characters. 

  

Windows Basic Concepts  

Windows Basics 
Terminology | Mouse Clicks | Menus | File Extensions | Hardware 

https://www.russharvey.bc.ca/resources/windowsbasics.html#windowsterms
https://www.russharvey.bc.ca/resources/windowsbasics.html#mouse
https://www.russharvey.bc.ca/resources/windowsbasics.html#menu
https://www.russharvey.bc.ca/resources/windowsbasics.html#extensions
https://www.russharvey.bc.ca/resources/windowsbasics.html#hardware
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New to Computers? 

Fears related to “new” technology are nothing recent. The First Tech Support Guyis a 
humorous spoof on our discomfort with anything new. 

Introduction to Windows Basics 

This page discusses basic Microsoft Windows terminology and how to perform some 
basic Windows tasks. This page is not exhaustive, and will be developed as the need 
arises. 

Currently supported versions of Windows range from a focus on keyboard & mouse to 
the more recent emphasis on touch screens. Some of the content is legacy and may not 
apply to the version of Windows you're running. 

Helpful Outside Resources 

A good introductory magazine would be a great resource, since it will have more 
pictures and diagrams than I have placed here (and costs much less than a book). Tech 
books have a short shelf life and therefore are more expensive than novels. 

Be sure any material you purchase covers the version of Windows you're using. Get 
something that you understand yet will teach you new concepts. 

Conventions Used on this Page 

I'll use the term default to refer to the standard options enabled when Windows is 
installed without customization. If your computer is older or slower, I'd suggest removing 
any extras. 

Computer Basics — General Concepts & Terminology contains a description of many of 
the general terms used when describing computers and their operation that may not be 
fully explained on this page. 

Return to top 

https://www.youtube.com/watch?v=2TjK1i5encw
https://www.russharvey.bc.ca/resources/terminology.html
https://www.russharvey.bc.ca/resources/windowsbasics.html#top
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Windows Terminology 

The images on this page were mostly taken from Windows 7 and may look different 
than your computer. However, they will serve to introduce you to the general concepts. 

Starting with Windows 8, the touch-screen is emphasized which means less reliance on 
a mouse and keyboard and more like the experience with a tablet or smart phone. 

Windows 10 is a mobile-first, cloud-first touch-based operating system that can use a 
mouse for navigation. As such, it is moving away from the traditional Windows 
interfaces and precepts. The user has far less control over this version of Windows than 
any prior version. 

Common Windows Items 

The following are just some of the terms used to describe the Windows desktop you are 
likely to run into. Most are indicated in the diagram below the list: 

 Desktop refers to the background of your screen on which the various programs run. 
Think of your computer screen as your electronic desk. 

 Icons are those small pictures on the desktop and inside folders that represent various 
programs and sometimes folders. 

 Folders are containers that can contain icons, programs, data or other folders (sub-
folders). The default folder icon looks like a Manila file folder but the look varies with 
different Windows versions. 

 Title bar refers to the bar at the top of an open window that will tell you what the 
folder/window is (the title) and contains the minimize, maximize and close buttons. You 
can also use the title bar to move a window around. 

 Cursor is the graphic which indicates where the mouse is and what sort of action it is 
performing. The cursor will change from the default arrow to various shapes according to 
the purpose it is serving at the time. For instance, it may form an I-beam shape when 
you are selecting text in a document or a double-arrow when you are resizing a window. 

 Task bar refers to the bar usually at the bottom of your Windows screen (it can be 
moved) with the Start Button on the left and the clock on the right. 

 The Scroll Bar appears when there is more information in the window than can be 
displayed. This is usually a vertical scroll bar, but a horizontal scroll bar may display if 
the width of the window is too narrow. In some cases, Windows 10 hides scroll bars until 
you hover over them. 

 The Address Bar allows you to navigate up and down a series of windows by double-
clicking on a folder. The folder with the Back/Fwd Buttons in Windows 7 would allow you 
to return to the previous folder. 

While this list is based upon Windows, other operating systems like Mac and Linuxuse a 
lot of the same terminology. 

The Window 

The window (from which the term "Windows" is derived) has various elements. The 
most common are labelled in the Windows 7 diagram below: 

https://www.russharvey.bc.ca/resources/windows7.html
https://www.russharvey.bc.ca/resources/windows10.html
https://www.russharvey.bc.ca/resources/mac.html
https://www.russharvey.bc.ca/resources/linux.html
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This folder is one of the optional desktop folders called the User Files. Some of these 
folders are not standard in Windows 7 such as Dropbox and Screen Captures. 

 The Navigation Pane provides quick links to various folders and locations on your 
computer. 

 The Title Bar contains no text although it still provides the method for moving the folder. 
 My Documents contains most of your user documents and files (except for music, 

pictures and videos). 
 The Address Bar has a bread crumb menu. Clicking on any of the listed items (shown 

here as “ • Russ • ”) takes you to that folder. Clicking behind the address transforms it 
into the C:\Users\Russ\ format. 

o A longer address example would be “ • Russ • Pictures • Family • ” which would 
transforms into C:\Users\Russ\Pictures\Family. 

o Clicking on Pictures would take you back to the Pictures folder. 
o Clicking on Russ would take you to the folder shown in the diagram above. 

Windows 10's navigation pane and other features are different as are the menu items 
included but the basic principles are the same. 

https://www.dropbox.com/referrals/NTE1MDIwNjE5
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WINDOWS 7 CONTROL PANEL 
FEATURES 

Windows 7 Control Panel 

 

 

 

In the Windows 7 Control Panel Tutorial we will only cover 

the features that a senior or beginner computer user would 

be interested in. The Control panel is full of tools to change 
the way Windows looks and behaves. 

We will cover the topics of User Accounts and Family Safety, 

appearance and Personalization, and printers and Keyboard. 
You can click on any of these topics to jump ahead. 

We are going to start with User Accounts. To open the 

Control Panel Click on the windows logo in the lower left 

corner then click Control Panel in the right hand column. 

This will open the control panel window. 

 

 

 

User Accounts is a place where you can add or delete users, change a password or 

password protect your user account, Change the picture by your name when you log on or 
change the way you log on and off, or set parental controls 

User Accounts is a beneficial tool because it allows each user of the computer to have their 

own look and feel for the Windows Desktop, customize their own favorites on the web and 

have their own My Documents Folder. This is also great for Parents to monitor their 
children's computer usage. 
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All of the link options in the control panel are alphabetized. Click on the User Account link 
and we will get started. 

 

When the user Account Window opens you will see the three options. 

We will start by having a little fun with the picture that appears by our name when we log 
on. Click on Change your picture link. 

 

In this window you can change the picture that appears next to your name in the Start 

Menu and when you log on. Browse through the pictures and pick your favorite one then 



86 | P a g e  

 

click on it. If you have a favorite picture that does not appear in the list of default pictures 

click on the Browse for more pictures link and a window will open for you to choose one of 

your personal pictures. 

If you made any changes click on the Change Picture button. If no changes were made click 

on Cancel and it will take you to the user account window. 

Now we will go through one by one to learn more about making changes to a user account. 

You do not have to make any changes to your computer but I would like you to get a feel 
for all of the windows in case you need to make changes in the future. 

Click on Change your password 

 

If your account is currently password protected and you would like to change the password 

you would enter the information in each text box and the Change Password button at the 

bottom. Click Cancel if you have not made any changes and you will return to the Make 
changes to your user account window. 

Click on the Remove your password link. 

 

If you computer is currently password protected you can type your current password into 

the text box and click the Remove Password button and you will no longer need a password 
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to log into your computer. Click Cancel if you did not make and changes to return to the 
Make changes to your user account window. 

Click on the Change your account name link 

If you have a grandchild or child that no longer uses your computer or you purchased a 

used computer from someone you can put your name here or type the name of someone 

else that would use that account. If you did not make any Changes click cancel to return to 
the User Accounts Window. 

Next click on the Change your account type link. 

 

If you are doing this tutorial with your account you are probably set up as the administrator. 

As the administrator you can access all programs and files and install programs on the 

computer. If you are set up as a Standard User you might not be able to install certain 
programs. You will still be able to change your own password, picture and desktop settings. 

You cannot change an account to a Standard user if they are set up as an administrator and 

there is only one administrator account. You would need to create another administrator 
account before changing an administrator to a Standard user. 

If you made any changes click the cancel button to return to the user accounts window. 

To switch to another account on the computer and make the same changes or create a new 

account you would click the Manage Another Account link. 
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Click on the Create new account link. Enter the User's name and select what type of user 

you would like them to be then click Create New Account. 

If you did not create a new account click cancel to return to the Manage Accounts Window. 

Now we will move onto Parental Controls. Having 2 small children this is one of my favorite 

features of Windows 7. Parental Controls helps you to manage you children's computer 

usage, set limits on access to the web, the hours they can log on to the computer, and 

which games they can play. Click on the setup Parental controls link at the bottom of the 

window. 
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When the Parental Control Window 

Opens Click on a user that is not an 

administrator. 

 

 

 

In the Parental Control Setup 

Window Click On, enforce current 

settings under Parental Controls. 

This will allow changes to be made 

to the three options under Window 
Settings. 

The links that are currently off in the 

sample will take you to the same location at the Windows Setting links. They are just to let 

you know what controls have been set. 

 

 

 

Click on Time limits. In the time limit 

window click on blocks of time in the 

grid to block the selected user from 

logging onto the computer during the 
set times. 

Click OK to save the changes or cancel 

to discard and return to the parental 
control window. 

 

 

 

Under Windows Settings click Games. Click the 

Set game ratings link. 

The Windows 7 Games window allows the 

parent to either allow or block any games 

from being played, block games with a specific 

rating, and block games by a specific name. 

To block any games from being played click 

the no button under Can (user Name) play 
games? 
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If the user is allowed to play games but you want to control the rating click Set games 
ratings under Block (or allow) games by rating or content. 

The first selection you can make is to allow or block games that do not have a rating. Click 

either Allow games with no rating or Block games with no rating. Then read each rating 

under Which ratings are ok for (user name) to play? Then choose the types of games the 

user will be allowed to play. The selection you choose and everything above it will be 

allowed. If the Rating is below what you 

selected that game will be blocked from play. 

 

 

 

Use the scroll bar to move down the window 

to see more options to block games containing 

certain content. Scroll down through the list 

and place a check mark on any content you 

would like to block. Any game containing a 

marked content will be blocked regardless of 
the rating. 

Click OK if you made any changes or Cancel to 

return to the Parental Control Game settings 

and OK again to return to the main Parental 
Control window. 

The last option is allow and block specific 

programs. Click on Block or Allow specific 

programs link. 
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When the Block or allow specific programs window opens click on (user name) can only use 

the programs I allow button. It will take a minute for all the programs to load in the box 
below. 

When the program list is populated scroll through the list with the down arrow on the right 

of the box and check the box next to each program the user will be allowed to use. After 

you have finished checking the programs click OK to return to Parental Controls or if no 
changes were made click Cancel. 

Now reopen the control panel. Click on the Personalization link. 
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Notice the links in this window look familiar. We have already covered these in the Windows 

7 Desktop Tutorial. This is just another way to get to the same options. Please feel free to 
click each link to see if you recognize the windows 

When you are finished exploring the Personalization window click the back arrow in the 

upper left corner to return to the control panel. 

Click on the devices and printers link in the main control panel window. Printers have never 

been one of my favorite topics. There are so many different brands and types of printers, 

and they all install and work differently. The best advice I can give you is to follow the 
instructions that came with your printer for easy installation. 

https://www.free-computer-tutorials.net/windows-7-desktop.html
https://www.free-computer-tutorials.net/windows-7-desktop.html
https://www.free-computer-tutorials.net/windows-7-desktop.html
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The Printers Window will open. This window gives you all the information you need to know 

about the printers and devices you currently have installed on your computer. This window 

will provide a list of each device or printer. To get more information on any item in the list 

double click to open the properties window for that item. 

The Printers Window will tell you the name of your printer. When you place your mouse over 

a printer if there is any number other than 0 in the documents column or under the printer 

name there are print jobs that are either in the process of being printed or are stuck in the 

print queue. 

Double click on one of your printers to view the window with the list of print jobs and 

options to change print settings. 
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If you are having printer trouble this is the window you need to be in to see what is going 

on. Most of the time you have a print job stuck in the queue and it needs to be deleted 

before you can print another document or re-print the current document. 

To delete a document out of the print queue click on see what is printing then click the print 

job to select it and press the delete key on your keyboard. Sometimes you are able to 

restart the print job to make it work. To restart a print job you select the print job you want 
and click document in the top tool bar. Then click restart. 

Click the x in the upper right corner to return to the Printers window. 

The last topic on printers I want to cover is Add a printer. Click on the add a printer link in 

the top toolbar. 

This will open the Add Printer 

wizard. You can follow this wizard 

to install a printer. I am not going 

to go into detail here because 

every printer is different. If you 

have specific questions you can 

email me and I will send you an 

individual tutorial specified toward 

the precise brand of printer you are 
installing. 

Click the Cancel button to go back 

to the Printers window. Then click 

the upper left back arrow to return 
to the printer window. 

Once you are back to the Control 
panel click on the Keyboard icon link. 
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Control Panel In Windows 8 

Windows 8/8.1 doesn’t provide a Control Panel icon on desktop or on 
other visible area. But this menu still exists and it is the main 
dashboard to access and edit the settings for your Windows computer. 

METHOD 1: WINDOWS + X 
This method works for both desktop modes: Metro and classic. 

1 Press Windows + X 

Press Windows + X keys in the same time. This will open a new 
menu and there you can select the Control Panel. 

 

2 Access Control Panel 

Now you can click on the Control Panel link. 
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METHOD 2: USING WINDOWS EXPLORER 
1 Press Windows + E 

Press Windows + E keys. 
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2 This PC 

Then click on This PC 



98 | P a g e  

 

 

3 Go to Computer 

Then click on the Computer tab. 
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4 Go to Control Panel 

Then click on Open Control Panel. 
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METHOD 3: SEARCH IT 
1 Open the Search menu 

Press Windows + Q keys in the same time. 
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2 Search it 

Then search for Control Panel. 
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Note: Make sure that Everywhere is selected. 
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Tip: if you right click on Control Panel icon, you can Pin it to taskbar 

and you will always have it in the bottom of the screen. 
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METHOD 4: RUN MENU 
1 Press Windows + R 

 



105 | P a g e  

 

2 Search it 

Then type control panel, then hit Enter or press Ok. 

 

The Control Panel is now visible. 
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METHOD 5: THROUGH METRO INTERFACE 
1 Go to Apps view 

Move the mouse down (to bottom-left) until an arrow will appear. Then 

click on this arrow. 
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2 Go to Control panel 

Then, a new window will appear, with different applications and 

buttons. You can swipe to the right (yes, there are more items to the 

right) and click on Control Panel. 
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Alternatively, you can search for it in the search bar. 
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Tip: if you right click, then you can click on Open File Location and 

from there you can create a shortcut to Control Panel on your desktop.

 

******************************************************************* 
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UNIT-2 

MS WORD 
Step 1 − Click the Start button. 

 

Step 2 − Click the All Programs option from the menu. 
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Step 3 − Search for Microsoft Office from the submenu and click it. 
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Step 4 − Search for Microsoft Word 2010 from the submenu and click it. 
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This will launch the Microsoft Word 2010 application and you will see the 

following window. 



115 | P a g e  

 

 

Explore Window in Word 2010 
how to explore Window in Word 2010. Following is the basic window which 

you get when you start the Word application. Let us understand the various 

important parts of this window.. 
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File Tab 
The File tab replaces the Office button from Word 2007. You can click it to 

check the Backstage view. This is where you come when you need to 

open or save files, create new documents, print a document, and do other 

file-related operations. 
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Quick Access Toolbar 
This you will find just above the File tab. This is a convenient resting place 

for the mostfrequently used commands in Word. You can customize this 

toolbar based on your comfort. 

Ribbon 

 

Ribbon contains commands organized in three components − 

 Tabs − These appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout are examples of ribbon tabs. 

 Groups − They organize related commands; each group name appears below 

the group on the Ribbon. For example, group of commands related to fonts or 

group of commands related to alignment, etc. 

 Commands − Commands appear within each group as mentioned above. 

Title bar 
This lies in the middle and at the top of the window. Title bar shows the 

program and document titles. 

Rulers 
Word has two rulers - a horizontal ruler and a vertical ruler. The horizontal 

ruler appears just beneath the Ribbon and is used to set margins and tab 

stops. The vertical ruler appears on the left edge of the Word window and is 

used to gauge the vertical position of elements on the page. 

Help 
The Help Icon can be used to get word related help anytime you like. This 

provides nice tutorial on various subjects related to word. 
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Zoom Control 
Zoom control lets you zoom in for a closer look at your text. The zoom 

control consists of a slider that you can slide left or right to zoom in or out; 

you can click the + buttons to increase or decrease the zoom factor. 

View Buttons 
The group of five buttons located to the left of the Zoom control, near the 

bottom of the screen, lets you switch through the Word's various document 

views. 

 Print Layout view − This displays pages exactly as they will appear when 

printed. 

 Full Screen Reading view − This gives a full screen view of the document. 

 Web Layout view − This shows how a document appears when viewed by a 

Web browser, such as Internet Explorer. 

 Outline view − This lets you work with outlines established using Word’s 

standard heading styles. 

 Draft view − This formats text as it appears on the printed page with a few 

exceptions. For example, headers and footers aren't shown. Most people prefer 

this mode. 

Document Area 
This is the area where you type. The flashing vertical bar is called the 

insertion point and it represents the location where text will appear when 

you type. 

Status Bar 
This displays the document information as well as the insertion point 

location. From left to right, this bar contains the total number of pages and 

words in the document, language, etc. 

You can configure the status bar by right-clicking anywhere on it and by 

selecting or deselecting options from the provided list. 
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Dialog Box Launcher 
This appears as very small arrow in the lower-right corner of many groups 

on the Ribbon. Clicking this button opens a dialog box or task pane that 

provides more options about the group. 

Backstage View in Word 2010 
Getting to the Backstage View is easy: Just click the File tab, located in the 

upper-left corner of the Word Ribbon. If you already do not have any 

opened document, then you will see a window listing down all the recently 

opened documents as follows − 
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If you already have an opened document, then it will display a window 

showing detail about the opened document as shown below. Backstage view 

shows three columns when you select most of the available options in the 

first column. 

 

The first column of the backstage view will have following options − 

S.No Option & Description 

1 

Save 

If an existing document is opened, it will be saved as is, otherwise 

it will display a dialogue box asking for the document name. 

2 
Save As 

A dialogue box will be displayed asking for document name and 
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document type, by default it will save in word 2010 format with 

extension .docx. 

3 

Open 

This option is used to open an existing word document. 

4 

Close 

This option is used to close an open document. 

5 

Info 

This option displays information about the opened document. 

6 

Recent 

This option lists down all the recently opened documents 

7 

New 

This option is used to open a new document. 

8 

Print 

This option is used to print an open document. 

9 

Save & Send 

This option will save an open document and will display options to 

send the document using email, etc. 

10 

Help 

This option is used to get the required help about Word 2010. 

11 Options 
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This option is used to set various option related to Word 2010. 

12 

Exit 

Use this option to close the document and exit. 

Document Information 
When you click the Info option available in the first column, it displays the 

following information in the second column of the backstage view − 

 Compatibility Mode − If the document is not a native Word 

2007/2010 document, a Convert button appears here, enabling you to easily 

update its format. Otherwise, this category does not appear. 

 Permissions − You can use this option to protect your word document. You can 

set a password so that nobody can open your document, or you can lock the 

document so that nobody can edit your document. 

 Prepare for Sharing − This section highlights important information you 

should know about your document before you send it to others, such as a 

record of the edits you made as you developed the document. 

 Versions − If the document has been saved several times, you may be able to 

access the previous versions of it from this section. 

Document Properties 
When you click the Info option available in the first column, it displays 

various properties in the third column of the backstage view. These 

properties include the document size, the number of pages in the 

document, the total number of words in the document, the name of the 

author etc. 

You can also edit various properties by clicking on the property value and if 

the property is editable, then it will display a text box where you can add 

your text like title, tags, comments, Author. 
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Exit Backstage View 
It is simple to exit from the Backstage View. Either click on the File tab or 

press the Esc button on the keyboard to go back to the working mode of 

Word. 

Entering Text - Microsoft Word 2010 
let us discuss how to enter text with Microsoft Word 2010. Let us see how 

easy it is to enter text in a Word document. We assume you know that 

when you start Word, it displays a new document by default as shown 

below − 
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Document area is the area where you type your text. The flashing vertical 

bar is called the insertion point and it represents the location where the text 

will appear when you type. keep the cursor at the text insertion point and 

start typing the text. We typed only two words "Hello Word" as shown 

below. The text appears to the left of the insertion point as you type − 

 

The following are the two important points that will help you while typing − 

 You do not need to press Enter to start a new line. As the insertion point reaches 

the end of the line, Word automatically starts a new one. You will need to press 

Enter, to add a new paragraph. 

 When you want to add more than one space between words, use the Tab key 

instead of the spacebar. This way you can properly align text by using the 

proportional fonts. 
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Move Around in Word 2010 
we will discuss how to move around in Word 2010. Word provides a number 

of ways to move around a document using the mouse and the keyboard. 

To begin with, let us create some sample text. To create a sample text, 

there is a short cut available. Open a new document and type =rand() and 

press Enter. Word will create the following content for you − 

 

Moving with Mouse 
You can easily move the insertion point by clicking in your text anywhere on 

the screen. There may be instances when a document is big and you cannot 

see a place where you want to move. Here, you will have to use the scroll 

bars, as shown in the following screenshot − 
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You can scroll through your document by rolling your mouse wheel, which is 

equivalent to clicking the up-arrow or down-arrow buttons in the scroll bar. 

Moving with Scroll Bars 
As shown in the above screenshot, there are two scroll bars: one for 

moving vertically within the document, and one for moving horizontally. 

Using the vertical scroll bar, you may − 

 Move upward by one line by clicking the upward-pointing scroll arrow. 

 Move downward by one line by clicking the downward-pointing scroll arrow. 

 Move one next page, using the next page button (footnote). 

 Move one previous page, using the previous page button (footnote). 
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 Use the Browse Object button to move through the document, going from one 

chosen object to the next. 

Moving with Keyboard 
The following keyboard commands, used for moving around your document, 

also move the insertion point − 

Keystroke Where the Insertion Point Moves 

 Forward one character 

 Back one character 

 

Up one line 

 

Down one line 

PageUp To the previous screen 

PageDown To the next screen 

Home To the beginning of the current line 

End To the end of the current line 

You can move word by word or paragraph by paragraph. You would have to 

hold down the Ctrl key while pressing an arrow key, which moves the 

insertion point as described here − 

Key Combination Where the Insertion Point Moves 

Ctrl +  To the next word 

Ctrl +  To the previous word 

Ctrl +  To the start of the previous paragraph 

Ctrl +  To the start of the next paragraph 

Ctrl + PageUp To the previous browse object 

Ctrl + 

PageDown 

To the next browse object 
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Ctrl + Home To the beginning of the document 

Ctrl + End To the end of the document 

Shift + F5 To the last place you changed in your 

document. 

Moving with Go To Command 
Press the F5 key to use the Go To command. This will display a dialogue 

box where you will have various options to reach to a particular page. 

Normally, we use the page number, the line number or the section number 

to go directly to a particular page and finally press the Go To button. 

 

Save Document in Word 2010 
Saving New Document 

Once you are done with typing in your new Word document, it is time to 

save your document to avoid losing work you have done on a Word 

document. Following are the steps to save an edited Word document − 

Step 1 − Click the File tab and select the Save As option. 
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Step 2 − Select a folder where you will like to save the document, Enter 

the file name which you want to give to your document and Select the Save 

As option, by default it is the .docx format. 
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Step 3 − Finally, click on the Save button and your document will be saved 

with the entered name in the selected folder. 

Saving New Changes 
There may be an instance when you open an existing document and edit it 

partially or completely, or an instance where you may like to save the 

changes in between editing of the document. If you want to save this 

document with the same name, then you can use either of the following 

simple options − 
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 Just press the Ctrl + S keys to save the changes. 

 Optionally you can click on the floppy icon available at the top left corner and 

just above the File tab. This option will also help you save the changes. 

 You can also use the third method to save the changes, which is 

the Save option available just above the Save As option as shown in the above 

screenshot. 

If your document is new and it was never saved so far, then with either of 

the three options, Word will display a dialogue box to let you select a folder, 

and enter the document name as explained in case of saving new 

document. 

Opening a Document in Word 2010 
Opening New Document 

A new, blank document always opens when you start Microsoft Word. 

Suppose you want to start another new document while you are working on 

another document, or you closed an already opened document and want to 

start a new document. Here are the steps to open a new document − 

Step 1 − Click the File tab and select the New option. 
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Step 2 − When you select the New option from the first column, it will 

display a list of templates in the second column. Double-click on the Blank 

document; this is the first option in the template list. We will discuss the 

other templates available in the list in the following chapters. 

You should have your blank document as shown below. The document is 

now ready for you to start typing your text. 
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You can use a shortcut to open a blank document anytime. Try using 

the Ctrl + N keys and you will see a new blank document similar to the one 

in the above screenshot. 

Opening Existing Document 
There may be a situation when you open an existing document and edit it 

partially or completely. Follow the steps given below to open an existing 

document − 

Step 1 − Click the File tab and select the Open option. 
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Step 2 − This will display the following file Open dialog box. This lets you 

navigate through different folders and files, and also lets you select a file 

which you want to open. 
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Step 3 − Finally, locate and select a file which you want to open and click 

the small triangle available on the Open button to open the file. You will 

have different options to open the file, but simply use the Open option. 
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This will open your selected file. You can use the Open Read-Only option if 

you are willing just to read the file and you have no intention to modify, 

i.e., edit the file. Other options can be used for advanced usage. 

Closing a Document in Word 2010 
When you finish working with a document, you will proceed to close the 

document. Closing a document removes it from your computer screen and if 

you had other documents open, Word displays the last document you used 

otherwise, you see a blank Word window. Here are simple steps to close an 

opened document − 
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Step 1 − Click the File tab and select the Close option. 

 

Step 2 − When you select the Close option and if the document is not 

saved before closing, it will display the following Warning box asking 

whether the document should be saved or not. 
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Step 3 − To save the changes, click Save, otherwise click Don't Save. To 

go back to the document, click Cancel. This will close the document and if 

you have other documents open, Word displays the last document you 

used, otherwise, you see a blank Word window as shown below − 
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Insert Text in Word 2010 

Many times it is required to go back and insert additional text in an existing 

line. Microsoft Word provides two ways to insert text in existing text and we 

will show how to use both the methods of inserting text − 

Insert and Add Text 
First we will see how inserted text will be added into the existing content 

without replacing any existing content. 

Step 1 − Click the location where you wish to insert text; you can also use 

the keyboard arrows to locate the place where the text needs to be 

inserted. 
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Step 2 − Start typing the text that needs to be inserted. Word inserts the 

text to the left of the insertion point, moving the existing text to the right 
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Insert and Replace Text 
In the Insertion mode, text will be added into the existing content but same 

time it will over write all the content which comes in its way. 

Step 1 − Right-click the status bar and select the Overtype option from 

the displayed menu. 
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When you select the Overtype option, the status bar will show 

the insert mode as shown below − 
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Step 2 − Click on the Insert text available at the status bar and it will 

switch to the Overtype mode as shown below − 
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Step 3 − Now click the location where the text needs to be inserted or you 

can use the keyboard arrows to locate the place where the text needs to be 

inserted. 
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Step 4 − Start typing the text that needs to be inserted. Word will replace 

the existing text with the newly typed text without moving the position of 

the exiting test. 



146 | P a g e  

 

 

Note − Microsoft Word 2010 disabled the functionality of the Insert key 

and it does nothing, so you will have to follow-up with the above mentioned 

procedure to turn-on or turn-off the Insert mode. 

Select Text in Word 2010 
Selecting a text is one of the most important skills required while editing a 

word document. You can perform various operations on a selected text; you 

can delete the selected text, copy it, move it, apply formatting to it, change 

its capitalization, etc. 

The most common method of selecting a text is to click and drag the mouse 

over the text you want to select. Following table lists down a few other 

simple methods that will help you in selecting text in different scenarios − 

S.No Component & Selection Method 

1 Selecting text between two points 
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Click at the start of the block of text, hold down Shift, and click at 

the end of the block. 

2 

Selecting a single word 

Double-click anywhere on the word you want to select. 

3 

Selecting a paragraph 

Triple-click anywhere on the paragraph you want to select. 

4 

Selecting a sentence 

Hold down the Ctrl key and click anywhere in the sentence you 

want to select. 

5 

Selecting a column of text 

Hold down Alt, click and hold the mouse button, and drag over the 

column you want to select. 

Note that only one part of the document can be in the selected state. If you 

have one portion of the document in selected state and as soon as you try 

to select any other part of the document, previous part will automatically be 

de-selected. 

Using the Selection Bar 
The black shaded area in the following screen shot is called the selection 

bar. When you bring your cursor in this area, it turns into a rightward-

pointing arrow. 



148 | P a g e  

 

 

You can use the selection bar to select the various components of a 

document as described in the following table − 

S.No Component & Selection Method 

1 

Selecting a line 

Bring your mouse in the selection bar area and click in front of the 

line you want to select. 

2 

Selecting a paragraph 

Bring your mouse in the selection bar area and double click in front 

of the paragraph you want to select. 
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3 

Selecting the document 

Bring your mouse in the selection bar area and triple-click. 

Using the Keyboard 
Keyboard provides very good support when you want to select various 

components of the document as described in the following table − 

S.No Key & Selection Method Selecting Text 

1 

Ctrl + A 

Press Ctrl + A keys to select the entire document. 

2 

Shift 

Keep pressing the Shift key and use any of the arrow keys to 

select the portion of text. 

3 

F8 

Press F8 and then use any of the arrows keys to select the portion 

of text. 

4 

Ctrl + Shift + F8 

Press Ctrl + Shift + F8 and then use any of the arrows keys to 

select column of the text. 

Delete Text in Word 2010 
It is very common to delete text and retype the content in your Word 

document. You might type something you did not want to type or there is 

something extra which is not required in the document. Regardless of the 

reason, Word offers you various ways of deleting the text in partial or 

complete content of the document. 
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Using Backspace & Delete Keys 
The most basic deletion technique is to delete characters one at a time by 

pressing either the backspace key or the delete key. Following table 

describes how you can delete single character or a whole word by using 

either of these two keys − 

S.No Keys & Deletion Methods 

1 

Backspace 

Keep the insertion point just after the character you want to delete 

and press the Backspace key. Word deletes the character 

immediately to the left of the insertion point. 

2 

Ctrl + Backspace 

Keep the insertion point just after the word you want to delete and 

press Ctrl + Backspace key. Word deletes the whole word 

immediately to the left of the insertion point. 

3 

Delete 

Keep the insertion point just before the character you want to 

delete and press the Delete key. Word deletes the character 

immediately to the right of the insertion point. 

4 

Ctrl + Delete 

Keep the insertion point just before the word you want to delete 

and press Ctrl + Delete key. Word deletes the word immediately 

to the right of the insertion point. 

Using Selection Method 
You have learnt how to select various parts of a Word document. You can 

make use of that learning to delete those selected parts as described in the 

following table − 
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S.No Component Selection & Delete Methods 

1 

Deleting text between two points 

Click at the start of the block of text, hold down the Shift key, and 

click at the end of the block to select the portion of text and finally 

press either the Backspace key or the Delete key. 

2 

Deleting a single word 

Double-click anywhere on the word you want to delete and finally 

press either the Backspace key or the Delete key. 

3 

Deleting a paragraph 

Triple-click anywhere on the paragraph you want to delete and 

finally press either the Backspace key or the Delete key. 

4 

Deleting a sentence 

Hold down the Ctrl key and click anywhere in the sentence you 

want to delete and finally press either the Backspace or 

the Delete key. 

5 

Deleting a column of text 

Hold down the Alt key, click and hold the mouse button, and drag 

over the column you want to delete and finally press either 

the Backspace key or the Delete key. 

6 

Deleting a line 

Bring your mouse in the selection bar area and click in front of the 

line you want to delete and finally press either the Backspace key 

or the Delete key. 

7 Deleting entire document content 
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Press Ctrl + A keys to delete the entire document and finally press 

either the Backspace key or the Delete key. 

Note − The black shaded area in the following screen shot is called 

the selection bar. When you bring your cursor in this area, it turns into a 

rightward-pointing arrow. 

 
Move Text in Word 2010 

At times, it is required to move a text from one location to another location 

in the same document or in any another document. You can move text from 

one location in a document to another by using the drag-and-drop 

technique with the help of mouse. This tutorial will teach you how to use 

the drag and drop technique to move text. 
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Move within the same document 
Step 1 − Select a portion of the text using any of the text selection 

methods. 

 

Step 2 − Now take your mouse pointer over the selected text and hold the 

left button of the mouse and keep holding it while moving around the 

document. 

Step 3 − Take your mouse pointer to the place where you want to move 

the selected text and release the mouse button. You will see that the 

selected text is moved to the desired location. 
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Move within different documents 
You can move the selected text from one document to another document. 

Following are some simple steps which will help you in moving text from 

one document to another document. 

Step 1 − Keep both the documents opened and to ensure that both 

documents are visible, click the Arrange All button on the View tab on the 

Ribbon. 
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This will display both the documents as shown below − 
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Step 2 − Now, select a portion of the text using any of the text selection 

methods. 

Step 3 − Take your mouse pointer over the selected text and hold the left 

button of the mouse and keep holding it while moving around the 

document. 

Step 4 − Take your mouse pointer at the place in the second document 

where you want to move the selected text and release the mouse button. 

You will see that the selected text is moved to the desired location in the 

second document. 
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Note − In case you have more than two documents, you can use the Alt + 

Tab keys to switch through the different documents and select the desired 

destination document. 

Copy & Paste in Word 2010 
 In the previous chapter, we understood how we can select the desired text 

and move it to any other location in the same document or in any other 
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document. This tutorial will teach you how to use copy, cut and paste 

techniques to duplicate a text leaving the original text intact or removing 

the original text completely. 

To use copy and paste or cut and paste operations, Word makes use of a 

temporary memory which is called the clipboard. When you copy or cut a 

text, it stay on the clipboard temporarily and in the second step you can 

paste this content at the desired location. 

Copy & Paste Operation 
The Copy operation will just copy the content from its original place and 

create a duplicate copy of the content at the desired location without 

deleting the text from it's the original location. Following is the procedure to 

copy the content in word − 

Step 1 − Select a portion of the text using any of the text selection 

methods. 
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Step 2 − You have various options available to copy the selected text in 

clipboard. You can make use of any one of the options − 

 Using Right-Click − When you right-click on the selected text, it will display 

the copy option, click this option to copy the selected content in clipboard. 

 Using Ribbon Copy Button − After selecting text, you can use the copy button 

available at the ribbon to copy the selected content in clipboard. 

 Using Ctrl + c Keys − After selecting a text, just press Ctrl + c keys to copy 

the selected content in clipboard. 
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Step 3 − Finally click at the place where you want to copy the selected text 

and use either of these two simple options − 

 Using Ribbon Paste Button − Just click the Paste button available at the 

ribbon to paste the copied content at the desired location. 

 Using Ctrl + v Keys − This is simplest way of pasting the content. Just 

press Ctrl + v keys to paste the content at the new location. 

 

Note − You can repeat the Paste operation as many times as you like to 

paste the same content. 

Cut & Paste Operation 
The Cut operation will cut the content from its original place and move the 

content from its original location to a new desired location. Following is the 

procedure to move the content in word − 
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Step 1 − Select a portion of the text using any of the text selection 

methods. 

 

Step 2 − Now, you have various options available to cut the selected text 

and put it in the clipboard. You can make use of one of the options − 

 Using Right-Click − If right-click on the selected portion of text, it will 

display cut option, just click this option to cut the selected content and keep it 

in clipboard. 

 Using Ribbon Cut Button − After selecting a portion of text, you can use cut 

button available at the ribbon to cut the selected content and keep it in 

clipboard. 

 Using Ctrl + x Keys − After selecting a portion of text, just press Ctrl + x keys 

to cut the selected content and keep it in clipboard. 
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Step 3 − Finally, click at the place where you want to move the selected 

text and use either of these two simple options − 

 Using Ribbon Paste Button − Just click the Paste button available at the 

ribbon to paste the content at the new location. 

 Using Ctrl + v Keys − This is simplest way of pasting the content. Just 

press Ctrl + v keys to paste the content at the new location. 
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Note − You can repeat the Paste operation as many times as you like to 

paste the same content. 

Copy, Cut & Paste in different documents 
You can use the same procedure that we discussed above to copy and 

paste or cut and paste content from one document to another document. 

This is very simple, just copy or cut the desired content from one document 

and go into another document where you want to paste the content and use 

mentioned step to paste the content. 

You can use the Alt + Tab keys to switch through the different documents 

and select the desired destination document. 

Find & Replace in Word 2010 
While working on editing a document you come across a situation very 

frequently when you want to search a particular word in your document and 
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many times you will be willing to replace this word with another word at a 

few or all the places throughout the document. Here, we will understand 

how to find a word or phrase in a word document and how to replace an 

existing word with any other word using simple steps. 

Find Command 
The Find command enables you to locate specific text in your document. 

Following are the steps to find a word document in the following screen − 

Step 1 − Let us work out on a sample text available in our Word document. 

Just type =rand() and press Enter; the following screen will appear − 

 

Step 2 − Click the Find option in the Editing group on the Home tab or 

press Ctrl + F to launch the Navigation pane − 
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Step 3 − Enter a word which you want to search in the Search box, as soon 

as you finish typing, Word searches for the text you entered and displays 

the results in the navigation pane and highlights the word in the document 

as in the following screenshot − 
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Step 4 − You can click the clear button (X) to clear the search and 

results and perform another search. 

Step 5 − You can use further options while searching for a word. Click 

the option button to display the options menu and then click 

the Options option; this will display a list of options. You can select the 

options like match case to perform case-sensitive search. 



167 | P a g e  

 

 

Step 6 − Finally, if you are done with the Search operation, you can click 

the close button (X) to close the Navigation Pane. 

Find & Replace Operation 
We assume you are an expert in searching a word or phrase in a word 

document as explained above. This section will teach you how you can 

replace an existing word in your document. Following are the simple steps 

− 

Step 1 − Click the Replace option in the Editing group on the Home tab 

or press Ctrl + H to launch the Find and Replace dialog box shown in 

Step 2 − 
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Step 2 − Type a word which you want to search. You can also replace the 

word using the Find and Replace dialog box as in the following screenshot 

− 
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Step 3 − Click the Replace button available on the Find and 

Replace dialog box and you will see the first occurrence of the searched 

word would be replaced with the replace with word. Clicking again 

on Replace button would replace next occurrence of the searched word. If 

you will click Replace All button then it would replace all the found words 

in one go. You can also use Find Next button just to search the next 

occurence and later you can use Replace button to replace the found word. 

Step 4 − You can use More >> button available on the dialog box to use 

more options and to make your search more specific like case sensitive 

search or searching for whole word only etc. 
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Step 5 − Finally, if you are done with the Find and Replace operation, you 

can click the Close (X) or Cancel button of the dialog box to close the box. 

Spell Check in Word 2010 
Microsoft Word provides a decent Spelling and Grammar Checker which 

enables you to search for and correct all spelling and grammar mistakes in 

your document. Word is intelligent enough to identify misspelled or 

misused, as well as grammar errors and underlines them as follows. 

 A red underline beneath spelling errors. 

 A green underline beneath grammar errors. 

 A blue line under correctly spelled but misused words. 

Check Spelling and Grammar using Review 

tab 
Here is the simple procedure to find out the spelling mistakes and fix them 

− 

Step 1 − Click the Review tab and then click the Spelling & 

Grammar button. 
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Step 2 − A Spelling and Grammar dialog box will appear and will display 

the wrong spellings or errors in grammar. You will also get suggestions to 

correct as shown below − 
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Now you have following options to fix the spelling mistakes − 

 Ignore − If you are willing to ignore a word, then click this button and Word 

ignores the word throughout the document. 

 Ignore All − Like Ignore, but this ignores all occurrences of the same 

misspelling, not just once but throughout the document. 

 Add to Dictionary − Choose Add to Dictionary to add the word to the Word 

spelling dictionary. 

 Change − This will change the wrong word using the suggested correct word. 

 Change All − Like Change, but this changes all occurrences of the same 

misspelling, not just once but throughout the document. 
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 AutoCorrect − If you select a suggestion, Word creates an AutoCorrect entry 

that automatically corrects this spelling error from now on. 

Following are the different options in case you have grammatical mistake − 

 Next Sentence − You can click Next Sentence to direct the grammar checker 

to skip ahead to the next sentence. 

 Explain − The grammar checker displays a description of the rule that caused 

the sentence to be flagged as a possible error. 

 Options − This will open the Word Options dialog box to allow you to change 

the behavior of the grammar checker or spelling options. 

 Undo − This will undo the last grammar changed. 

Step 3 − Select one of the given suggestions you want to use and click 

the Change option to fix the spelling or grammar mistake and repeat the 

step to fix all the spelling or grammar mistake. 

Step 4 − Word displays a dialog box when it finishes checking for spelling 

and grammar mistakes, finally Click OK. 
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Check Spelling and Grammar using Right 

Click 
If you will right-click the mouse button over a misspelled word, then it will 

show you the correct suggestions and the above mentioned options to fix 

the spelling or grammar mistake. Try it yourself. 
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Text Alignments in Word 2010 

There are four types of paragraph alignment available in Microsoft Word — 

left-aligned, center-aligned, rightaligned, and justified. 

Left-Aligned Text 
A paragraph's text is left aligned when it is aligned evenly along the left 

margin. Here is a simple procedure to make a paragraph text left-aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click 

the Align Text Left button available on the Home tab or simply press 

the Ctrl + L keys. 
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Center Aligned Text 
A paragraph's text will be said center aligned if it is in the center of the left 

and right margins. Here is a simple procedure to make a paragraph text 

center aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click 

the Center button available on the Home tab or simply press the Ctrl + 

E keys. 
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Right-Aligned Text 
A paragraph's text is right-aligned when it is aligned evenly along the right 

margin. Here is a simple procedure to make a paragraph text right-aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click 

the Align Text Right button available on the Home tab or simply press 

the Ctrl + R keys. 



178 | P a g e  

 

 

Justified Text 
A paragraph's text is justified when it is aligned evenly along both the left 

and the right margins. Following is a simple procedure to make a paragraph 

text justified. 

Step 1 − Click anywhere on the paragraph you want to align and click 

the Justify button available on the Home tab or simply press the Ctrl + 

J keys. 
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When you click the Justify button, it displays four options, justify, justify 

low, justify high and justify medium. You need to select only the justify 

option. The difference between these options is that low justify creates little 

space between two words, medium creates a more space than low justify 

and high creates maximum space between two words to justify the text. 

Indent Paragraphs in Word 2010 
As you know the margin settings determine the blank space that appears on 

each side of a paragraph. You can indent paragraphs in your document 

from the left margin, the right margin, or both the margins. This chapter 

will teach you how to indent your paragraphs with or without the first line of 

the paragraphs. 
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Left Indentation 
Left indentation means to move the left edge of the paragraph inward 

towards the center of the paragraph. Let us use the following steps to 

create left indentation. 

Step 1 − Click anywhere on the paragraph you want to indent left and click 

the Increase Indent button available on the Home tab or simply press 

the Ctrl + M keys. You can click multiple times to create deeper 

indentation. 

 

Step 2 − You can remove left indentation by clicking the Decrease 

Indent button available on Home tab or simply press Ctrl + Shift+ 

M keys. You can click multiple times to remove deeper indentation. 

You can also use the Paragraph Dialog Box to set left and right 

indentations. We will see this dialog box in the last section of this chapter. 
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Right Indentation 
Right indentation means to move the right edge of the paragraph inward 

towards the center of the paragraph. Let us use the following steps to 

create right indentation. 

Step 1 − Click anywhere on the paragraph you want to indent and then 

click on the Increase Right Indent spinner available on the Page Layout tab. 

You can click on the spinner multiple times to create deeper indentation. 

You can use the Left Indent spinners as well to set left indentation from the 

same place. 

 

Step 2 − You can remove right indentation by clicking the Decrease Right 

Indent spinner in the opposite direction. 

You can also use the Paragraph Dialog Box to set the left and the right 

indentations. We will see this dialog box in the next section. 
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First Line Indentation 
You can move the left side of the first line of a paragraph inward toward the 

center. Let us see the procedure to perform first line indentation. 

Step 1 − Click anywhere on the paragraph you want to indent right and 

click the Paragraph Dialog Box launcher available on the Home tab. 

Step 2 − Click the Before Text spinner to set left indentation and select 

the First Line Option to move the left side of the first line of a paragraph 

inward toward the center. You can control the movement by setting 

the Indentation Unit. A preview box will give only the idea and not the 

indentation status. 
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Hanging Indentation 
You can move the left side of the first line of a paragraph leftward, away 

from the center which is called the hanging indentation. Let us see the 

procedure to perform hanging indentation. 

Step 1 − Click anywhere on the paragraph you want to indent right and 

click the Paragraph Dialog Box launcher available on the Home tab. 

Step 2 − Click the Before Text spinner to set left indentation and 

select Hanging Option to move the left side of the first line of a paragraph 

leftward, away from the center. You can control the movement by setting 

the Indentation Unit. A preview box will give only the idea and not the 

indentation status. 
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You can use the After Text spinner to set the right indentation. You can try 

it yourself. 

Borders and Shades in Word 2010 
Microsoft Word allows you to place a border on any or all of the four sides 

of selected text, paragraphs, and pages. You can also add different shades 

to the space occupied by the selected text, paragraphs, and pages. This 

chapter will teach you how to add any of the borders (left, right, top or 

bottom) around a text or paragraph or a page and how to add different 

shadows to them. 

Add Borders to Text 
Following are the simple steps to add border to any text or paragraph. 

Step 1 − Select the portion of text or paragraph to which you want to add 

border. You can use any of the text selection method to select the 

paragraph(s). 

Step 2 − Click the Border Button to display a list of options to put a 

border around the selected text or paragraph. You can select any of the 

option available by simply clicking over it. 
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Step 3 − Try to add different borders like left, right top or bottom by 

selecting different options from the border options. 



186 | P a g e  

 

 

Step 4 − To delete the existing border, simply select the No Border option 

from the border options. 

Note − You can add a horizontal line by selecting the Horizontal 

Line option from the border options. Otherwise type --- (three hyphens) 

and press ENTER. A single, light horizontal line will be created between the 

left and the right margins. 

Add Borders to Page 
You can add borders of your choice to word pages by following the steps 

given below. 

Step 1 − Click the Border Button to display a list of options to put a 

border. Select the Border and Shading option available at the bottom of 

the list of options as shown in the above screenshot. This will display 

a Border and Shading dialog box. This dialog box can be used to set 

borders and shading around a selected text or page borders. 
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Step 2 − Click the Page Border tab which will display a list of border 

settings, styles and options whether this border should be applied to the 

whole document or just one page or the first page. 

Step 3 − You can use the Preview section to disable or enable left, right, 

top or bottom borders of the page. Follow the instruction given in the 

preview section itself. 

Step 4 − You can customize your border by setting its color, width by using 

different art available under the style section. 
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You can have similar or even better borders as given below. 
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Add Shades to Text 
The following steps will help you understand how to add shades on a 

selected portion of text or a paragraph(s). 

Step 1 − Click the Border Button to display a list of options to put a 

border. Select the Border and Shading option available at the bottom of 

the list of options as shown in the above screenshot. This will display 

a Border and Shading dialog box. This dialog box can be used to set 

borders and shading around a selected portion of text or page borders. 
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Step 2 − Click the Shading tab; this tab will display the options to 

select fill, color and style and whether this border should be applied to a 

paragraph or a portion of text. 

Step 3 − You can use the Preview section to have an idea about the 

expected result. Once you are done, click the OK button to apply the result. 
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Header and Footer in Word 2010 

Headers and footers are parts of a document that contain special 

information such as page numbers and the total number of pages, the 

document title, company logo, any photo, etc. The header appears at the 

top of every page, and the footer appears at the bottom of every page. 

Add Header and Footer 
The following steps will help you understand how to add header and footer 

in a Word document. 

Step 1 − Click the Insert tab, and click either the Header button or 

the Footer button that which needs to be added first. Assume you are 

going to add Header; when you click the Header button it will display a list 

of built-in Headers from where you can choose any of the headers by simply 

clicking on it. 
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Step 2 − Once you select any of the headers, it will be applied to the 

document in editable mode and the text in your document will appear 

dimmed, Header and Footer buttons appear on the Ribbon and a Close 

Header and Footer button will also appear at the top-right corner. 
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Step 3 − Finally, you can type your information whatever you want to have 

in your document header and once you are done, click Close Header and 

Footer to come out of the header insertion mode. You will see the final 

result as follows. 
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You can follow a similar procedure to add footer in your document. 

Edit Header and Footer 
The following steps will help you understand how to edit the existing header 

or footer of your document. 

Step 1 − Click the Insert tab, and click either the Header 

button or Footer button or whatever you want to edit. Assume you are 

going to edit the Header, so when you click the Header button it will 

display a list of options including the Edit Header option. 



195 | P a g e  

 

 

Step 2 − Click on the Edit Header option and Word will display the editable 

header as shown in the following screenshot. 
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Step 3 − Now you can edit your document header and once you are done, 

click Close Header and Footer to come out of the edit header mode. 

You can follow a similar procedure to edit the footer in your document. 

********************************************* 
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UNIT-4 

MS Powerpoint 
Step 1 − Click the Start button. 

 

Step 2 − Click All Programs option from the menu. 
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Step 3 − Search for Microsoft Office from the sub menu and click it. 
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Step 4 − Search for Microsoft PowerPoint 2010 from the submenu and 

click it. 

 

This will launch the Microsoft PowerPoint 2010 application and you will see 

the following presentation window. 

 The 

following screenshot shows the various areas in a standard PowerPoint file. 
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It is important to familiarize yourself with these areas as it makes learning 

and using PowerPoint easier. 

 

File Tab 
This tab opens the Backstage view which basically allows you to manage 

the file and settings in PowerPoint. You can save presentations, open 

existing ones and create new presentations based on blank or predefined 

templates. The other file related operations can also be executed from this 

view. 
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Ribbon 

 

The ribbon contains three components − 

 Tabs − They appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout are examples of ribbon tabs. 

 Groups − They organize related commands; each group name appears below 

the group on the Ribbon. For example, a group of commands related to fonts or 

a group of commands related to alignment, etc. 

 Commands − Commands appear within each group as mentioned above. 

Title Bar 
This is the top section of the window. It shows the name of the file followed 

by the name of the program which in this case is Microsoft PowerPoint. 

Slide Area 
This is the area where the actual slide is created and edited. You can add, 

edit and delete text, images, shapes and multimedia in this section. 

Help 
The Help Icon can be used to get PowerPoint related help anytime you 

need. Clicking on the "?" opens the PowerPoint Help window where you 

have a list of common topics to browse from. You can also search for 

specific topics from the search bar at the top. 
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Zoom Options 
The zoom control lets you zoom in for a closer look at your text. The zoom 

control consists of a slider that you can slide left or right to zoom in or out, 

you can click on the - and + buttons to increase or decrease the zoom 

factor. The maximum zoom supported by PowerPoint is 400% and the 

100% is indicated by the mark in the middle. 

Slide Views 
The group of four buttons located to the left of the Zoom control, near the 

bottom of the screen, lets you switch between PowerPoint views. 

 Normal Layout view − This displays page in normal view with the slide on the 

right and a list of thumbnails to the left. This view allows you to edit individual 

slides and also rearrange them. 

 Slide Sorter view − This displays all the slides as a matrix. This view only 

allows you to rearrange the slides but not edit the contents of each slide. 

 Reading View − This view is like a slideshow with access to the Windows task 

bar in case you need to switch windows. However, like the slideshow you cannot 

edit anything in this view. 

Notes Section 
This sections allows you to add notes for the presentation. These notes will 

not be displayed on the screen during the presentation; these are just quick 

reference for the presenter. 

Quick Access Toolbar 
The Quick Access Toolbar is located just under the ribbon. This toolbar 

offers a convenient place to group the most commonly used commands in 

PowerPoint. You can customize this toolbar to suit your needs. 

Slide Tab 
This section is available only in the Normal view. It displays all the slides in 

sequence. You can add, delete and reorder slides from this section. 
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n Office 2010, Microsoft replaced the traditional file menu with the 

new Backstage view. This view not only offers all the menu items under 

the file menu, but additional details which makes management of your files 

a lot easier. 

Accessing Backstage View 
You can access the Backstage view simply by clicking on the File tab. You 

can exit this view by clicking on any tab (including the File tab again). You 

can also press the 'Esc' button on the keyboard. 

 

Organization of Backstage View 
The backstage view has three sections or panes. 
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 First Pane − This is the commands pane which consists of all the commands 

you would typically find in the file menu of older versions. You also have 

the Options menu which lets you edit the options on the program like 

customizing the ribbon. 

Various commands under the first pane are described in the table below − 

S.No Command & Description 

1 
Save 

This allows you to save a new file or an existing file in standard 

format. If you are working on a previously saved file this will save 

the new changes in the same file format. If you are working on a 
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new file, this command would be similar to the Save As command. 

2 
Save As 

Allows you to specify the file name and the file type before saving 

the file. 

3 
Open 

Allows you to open new PowerPoint files. 

4 
Close 

Allows you to close an existing file. 

5 
Info 

Displays the information about the current file. 

6 
Recent 

Lists series of recently viewed or edited PowerPoint files. 

7 
New 

Allows you to create a new file using blank or pre-defined 

templates. 

8 
Print 

Allows you to select the printer settings and print the presentation. 

9 
Save & Send 

Allows you to share your presentation with larger audience via 

emails, web, cloud services, etc. 
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10 
Help 

Provides access to PowerPoint Help. 

11 
Options 

Allows you to set various options related to PowerPoint program. 

12 
Exit 

Closes the presentation and exits the program. 

 Second Pane − This is the subcommands pane. This will list all the commands 

related to the main command you choose in the first pane. For example, if you 

select Print in the first pane, you get to choose the printer and adjust the print 

settings in the second pane. 

 Third Pane − This is the preview or file information page. Depending on the 

command and the subcommand you select, this pane will either display the 

properties of the file or give you a preview of the file. 

Create Presentation using Powerpoint 
PowerPoint offers a host of tools that will aid you in creating a presentation. 

These tools are organized logically into various ribbons in PowerPoint. The 

table below describes the various commands you can access from the 

different menus. 
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Menu Category Ribbon Commands 

Home Clipboard functions, manipulating slides, fonts, paragraph 

settings, drawing objects and editing functions. 

Insert Insert tables, pictures, images, shapes, charts, special texts, 

multimedia and symbols. 

Design Slide setup, slide orientation, presentation themes and 
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background. 

Transitions Commands related to slide transitions. 

Animations Commands related to animation within the individual slides. 

Slide Show Commands related to slideshow set up and previews. 

Review Proofing content, language selection, comments and 
comparing presentations. 

View Commands related to presentation views, Master slides, color 
settings and window arrangements. 

Besides these depending on the objects selected in the slide, there are 

other menu tabs that get enabled. 

Add New Slides in Powerpoint 
Step 1 − Right-click in the Navigation Pane under any existing slide and 

click on the New Slide option. 
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Step 2 − The new slide is inserted. You can now change the layout of this 

slide to suit your design requirements. 
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Step 3 − To change the slide layout, right-click on the newly inserted slide 

and go to the Layout option where you can choose from the existing layout 

styles available to you. 
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You can follow the same steps to insert a new slide in between existing 

slides or at the end on the slide list. 

When we insert a new slide, it inherits the layout of its previous slide with 

one exception. If you are inserting a new slide after the first slide 

(Title slide), the subsequent slide will have the Title and Content layout. 

You will also notice that if you right-click in the first step without selecting 

any slide the menu options you get are different, although you can insert a 

new slide from this menu too. 
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Adding Text in Boxes in Powerpoint  

PowerPoint allows users to add text to the slide in a well-defined manner to 

ensure the content is well distributed and easy to read. The procedure to 

add the text in a PowerPoint slide is always the same - just click in the text 

box and start typing. The text will follow the default formatting set for the 

text box, although this formatting can be changed later as required. What 

changes is the different kinds of content boxes that support text in a 

PowerPoint slide. 

Given below are some of the most common content blocks you will see in 

PowerPoint. 

Title Box 
This is typically found on slides with the title layout and in all the slides that 

have a title box in them. This box is indicated by "Click to add title". 
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Subtitle Box 
This is found only in slides with the Title layout. This is indicated by "Click 

to add subtitle" 

Content Box 
This is found in most of the slides that have a placeholder for adding 

content. This is indicated by "Click to add text". As you can see, this box 

allows you to add text as well as non-text content. To add text to such a 

box, click anywhere on the box, except on one of the content icons in the 

center and start typing. 



215 | P a g e  

 

 

Text Only Box 
This is not a default content box available in PowerPoint, but you can create 

it using Slide Master, if required. This is also indicated by "Click to add 

text". The only difference between the Text Only Box and the Content 

Box is that the former only supports text in the content area. 
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Deleting Existing Slide in Powerpoint 

There are times while building a slide deck, you may need to delete some 

slides. This can be done easily from PowerPoint. You can delete the slides 

from the Normal view as well as the Slide Sorter view. In each view, you 

can delete the slides in two ways. 

Deleting from Normal View 
Step 1 − Go to the Normal view. 
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Step 2 − Right-click on the slide to be deleted and select the Delete 

Slide option. 
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Alternately, you can select the slide and press the Delete button on your 

key board. 

Deleting from Slide Sorter View 
Let us now understand how to deleted slides from the Slide Sorter View. 

Step 1 − Go to the Slide Sorter view. 
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Step 2 − Right-click on the slide to be deleted and select the Delete 

Slide option. 
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Alternately, you can select the slide and press the Delete button on your 

key board. 

Rearranging Slides in Powerpoint 
Rearranging slides is important when it comes to organizing the overall 

presentation flow. While it is vital that you get the right content in every 

slide, it is equally important that you are able to present them in a format 

that makes it easier for the audience to understand the content too; most 

times this will require rearranging the slides. 

You can rearrange slides from two views in PowerPoint - Normal 

View and Slide Sorter View. Given below are the steps to rearrange 

slides from different views. 

Normal View 
Step 1 − Select the slide to be moved. 
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Step 2 − Left click on the slide and drag it to the position in the sequence 

where you want to place it. PowerPoint will indicate the insert position with 

a line in-between existing slides. 

 

Step 3 − When you get to the right position release the left click button to 

insert the slide. Alternately you can also cut the selected slide and paste it 

back in the sequence as shown below. 
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Slide Sorter View 
Let us now understand how the Slide Sorter View works. 

Step 1 − Select the slide to be moved. 

Step 2 − Left click on the slide and drag it to the position in the sequence 

where you want to place it. PowerPoint will indicate the insert position with 

a line in-between existing slides. 
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Step 3 − When you get to the right position release the left click button to 

insert the slide. Alternately you can also cut the selected slide and paste it 

back in the sequence as shown below. 
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Adding Slide Notes Powerpoint 

Slide notes can be very useful tools for presentation. These notes are not 

displayed on the screen in the Slideshow mode, but the presenter can see 

them so they can prepare well to present the slides. Depending on your 

Print settings, you can also print the slide notes along with the slides. 

This chapter will show you how to add slide notes to an existing 

presentation. 

Step 1 − To locate the slide notes, set the view in Normal mode. 
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Step 2 − The Slide Notes section is indicated by "Click to add notes". 
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Step 3 − You can click on the top border and drag the section to increase 

its size to make it easier to type. 
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Step 4 − Type your text in this section as slide notes. 
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You can only use bullets, numbering and alignment functions in the Slide 

Notes section. All other functions can be selected, but can be applied only 

to the selected slide, not the notes. 

Slide notes can be printed from the print menu under the Backstage view. 

From the Print Layout option, select Notes Pages or 3 Slides. Notes Pages 

will print a single slide with the slide notes below it. The 3 Slides will print 

all three slides with notes on the right side. 
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 Managing Sections in Powerpoint 
Creating Sections 

The steps to create a new section are as follows. You can execute these 

steps from the Normal view or the Slide Sorter view. 

Step 1 − In the Normal view or the Slide Sorter view, right-click at the 

position where you want to add the section and select add section. 
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Step 2 − The new section gets added to the presentation with all the 

subsequent slides being included in this section. 
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Step 3 − By default, the new section is named "Untitled Section" but you 

can change the section name. Right-click on the section and select 

"Rename Section". 
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Step 4 − In the Rename Section dialog box, enter the new section name. 

This accepts all the characters including alphabets, numbers, special 

characters, punctuations, etc. 
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Step 5 − Click on the "Rename" button on the dialog to rename the 

section. 



239 | P a g e  

 

 



240 | P a g e  

 

 

Rearranging Sections 
One of the advantages of sections is that you can not only group slides 

together, but also rearrange them as one set. Instead of having to move 

each slide individually, you can move the entire section. Just like 

rearranging slides you can drag and move the sections. Alternately, you can 

right-click on the section and move it up or down as shown below. 
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If there are many slides to work with, you can collapse them so you view 

just the sections. This makes rearranging them less confusing too. 
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Deleting Sections 
PowerPoint 2010 provides three options to delete sections. The table below 

explains the function of each option. 
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S.No Delete Option & Description 

1 
Remove Section 

Deletes the selected section and merges slides with the previous 

section. 

2 
Remove Section & Slide 

Deletes the selected section and all the slides in the section. 
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3 
Remove All Sections 

Deletes all the sections and merges all the slides into a 

presentation without sections. 

Presentation Views in Powerpoint 
PowerPoint supports multiple views to allow users to gain the maximum 

from the features available in the program. Each view supports a different 

set of functions and is designed accordingly. 

PowerPoint views can be accessed from two locations. 

 Views can be accessed quickly from the bottom bar just to the left of the zoom 

settings. 
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 Views can also be accessed from the Presentation Views section in the View 

ribbon 

 

Here is a short description of the various views and their features. 
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Normal View 
This is the default view in PowerPoint and this is primarily used to create 

and edit slides. You can create/ delete/ edit/ rearrange slides, add/ remove/ 

modify content and manipulate sections from this view. 

 

Slide Sorter View 
This view is primarily used to sort slides and rearrange them. This view is 

also ideal to add or remove sections as it presents the slides in a more 

compact manner making it easier to rearrange them. 
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Reading View 
This view is new to PowerPoint 2010 and it was created mainly to review 

the slideshow without losing access to rest of the Windows applications. 

Typically, when you run the slideshow, the presentation takes up the entire 

screen so other applications cannot be accessed from the taskbar. In the 

reading view the taskbar is still available while viewing the slideshow which 

is convenient. You cannot make any modifications when on this view. 
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SlidesShow 
This is the traditional slideshow view available in all the earlier versions of 

PowerPoint. This view is used to run the slideshow during presentation. 
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Getting Started with Excel 

Step 1 − Click on the Start button. 

 

Step 2 − Click on All Programs option from the menu. 
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Step 3 − Search for Microsoft Office from the sub menu and click it. 

 

Step 4 − Search for Microsoft Excel 2010 from the submenu and click it. 
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This will launch the Microsoft Excel 2010 application and you will see the 

following excel window. 

 
Explore Window in Excel 
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The following basic window appears when you start the excel application. 

Let us now understand the various important parts of this window. 

 

File Tab 
The File tab replaces the Office button from Excel 2007. You can click it to 

check the Backstage view, where you come when you need to open or 

save files, create new sheets, print a sheet, and do other file-related 

operations. 
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Quick Access Toolbar 
You will find this toolbar just above the File tab and its purpose is to 

provide a convenient resting place for the Excel's most frequently used 

commands. You can customize this toolbar based on your comfort. 

Ribbon 

 

Ribbon contains commands organized in three components − 

 Tabs − They appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout are the examples of ribbon tabs. 

 Groups − They organize related commands; each group name appears below 

the group on the Ribbon. For example, group of commands related to fonts or 

group of commands related to alignment etc. 

 Commands − Commands appear within each group as mentioned above. 

Title Bar 
This lies in the middle and at the top of the window. Title bar shows the 

program and the sheet titles. 

Help 
The Help Icon can be used to get excel related help anytime you like. This 

provides nice tutorial on various subjects related to excel. 

Zoom Control 
Zoom control lets you zoom in for a closer look at your text. The zoom 

control consists of a slider that you can slide left or right to zoom in or out. 

The + buttons can be clicked to increase or decrease the zoom factor. 
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View Buttons 
The group of three buttons located to the left of the Zoom control, near the 

bottom of the screen, lets you switch among excel's various sheet views. 

 Normal Layout view − This displays the page in normal view. 

 Page Layout view − This displays pages exactly as they will appear when 

printed. This gives a full screen look of the document. 

 Page Break view − This shows a preview of where pages will break when 

printed. 

Sheet Area 
The area where you enter data. The flashing vertical bar is called 

the insertion point and it represents the location where text will appear 

when you type. 

Row Bar 
Rows are numbered from 1 onwards and keeps on increasing as you keep 

entering data. Maximum limit is 1,048,576 rows. 

Column Bar 
Columns are numbered from A onwards and keeps on increasing as you 

keep entering data. After Z, it will start the series of AA, AB and so on. 

Maximum limit is 16,384 columns. 

Status Bar 
This displays the sheet information as well as the insertion point location. 

From left to right, this bar can contain the total number of pages and words 

in the document, language etc. 

You can configure the status bar by right-clicking anywhere on it and by 

selecting or deselecting options from the provided list. 
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Dialog Box Launcher 
This appears as a very small arrow in the lower-right corner of many groups 

on the Ribbon. Clicking this button opens a dialog box or task pane that 

provides more options about the group. 

Entering Values in Excel 
Entering values in excel sheet is a child’s play and this chapter shows how 

to enter values in an excel sheet. A new sheet is displayed by default when 

you open an excel sheet as shown in the below screen shot. 

 

Sheet area is the place where you type your text. The flashing vertical bar 

is called the insertion point and it represents the location where text will 
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appear when you type. When you click on a box then the box is highlighted. 

When you double click the box, the flashing vertical bar appears and you 

can start entering your data. 

So, just keep your mouse cursor at the text insertion point and start typing 

whatever text you would like to type. We have typed only two words "Hello 

Excel" as shown below. The text appears to the left of the insertion point as 

you type. 

 

There are following three important points, which would help you while 

typing − 

 Press Tab to go to next column. 

 Press Enter to go to next row. 

 Press Alt + Enter to enter a new line in the same column. 
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Save Workbook in Excel 
Saving New Sheet 

Once you are done with typing in your new excel sheet, it is time to save 

your sheet/workbook to avoid losing work you have done on an Excel sheet. 

Following are the steps to save an edited excel sheet − 

Step 1 − Click the File tab and select Save As option. 
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Step 2 − Select a folder where you would like to save the sheet, Enter file 

name, which you want to give to your sheet and Select a Save as type, by 

default it is .xlsx format. 

 

Step 3 − Finally, click on Save button and your sheet will be saved with 

the entered name in the selected folder. 
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Saving New Changes 
There may be a situation when you open an existing sheet and edit it 

partially or completely, or even you would like to save the changes in 

between editing of the sheet. If you want to save this sheet with the same 

name, then you can use either of the following simple options − 

 Just press Ctrl + S keys to save the changes. 

 Optionally, you can click on the floppy icon available at the top left corner and 

just above the File tab. This option will also save the changes. 

 You can also use third method to save the changes, which is the Save option 

available just above the Save As option as shown in the above screen capture. 

If your sheet is new and it was never saved so far, then with either of the 

three options, word would display you a dialogue box to let you select a 

folder, and enter sheet name as explained in case of saving new sheet. 

Create Worksheet in Excel 
Creating New Worksheet 

Three new blank sheets always open when you start Microsoft Excel. Below 

steps explain you how to create a new worksheet if you want to start 

another new worksheet while you are working on a worksheet, or you 

closed an already opened worksheet and want to start a new worksheet. 

Step 1 − Right Click the Sheet Name and select Insert option. 
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Step 2 − Now you'll see the Insert dialog with select Worksheet option as 

selected from the general tab. Click the Ok button. 
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Now you should have your blank sheet as shown below ready to start typing 

your text. 
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You can use a short cut to create a blank sheet anytime. Try using 

the Shift+F11 keys and you will see a new blank sheet similar to the above 

sheet is opened. 

Delete Worksheet in Excel 
Delete Worksheet 

Here is the step to delete a worksheet. 

Step − Right Click the Sheet Name and select the Delete option. 
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Sheet will get deleted if it is empty, otherwise you'll see a confirmation 

message. 
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Press the Delete Button. 

Now your worksheet will get deleted. 

Close Workbook in Excel  
Close Workbook 

Here are the steps to close a workbook. 

Step 1 − Click the Close Button as shown below. 
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You'll see a confirmation message to save the workbook. 
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Step 2 − Press the Save Button to save the workbook as we did in MS 

Excel - Save Workbook 

Open Workbook in Excel 
Let us see how to open workbook from excel in the below mentioned steps. 

Step 1 − Click the File Menu as shown below. You can see the Open 

option in File Menu. 

There are two more columns Recent workbooks and Recent places, where 

you can see the recently opened workbooks and the recent places from 

where workbooks are opened. 

https://www.tutorialspoint.com/excel/excel_save_workbook.htm
https://www.tutorialspoint.com/excel/excel_save_workbook.htm
https://www.tutorialspoint.com/excel/excel_save_workbook.htm
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Step 2 − Clicking the Open Option will open the browse dialog as shown 

below. Browse the directory and find the file you need to open. 
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Step 3 − Once you select the workbook your workbook will be opened as 

below − 
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Insert Data in Excel 

In MS Excel, there are 1048576*16384 cells. MS Excel cell can 

have Text, Numeric value or formulas. An MS Excel cell can have 

maximum of 32000 characters. 

Inserting Data 
For inserting data in MS Excel, just activate the cell type text or number 

and press enter or Navigation keys. 
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Inserting Formula 
For inserting formula in MS Excel go to the formula bar, enter the formula 

and then press enter or navigation key. See the screen-shot below to 

understand it. 
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Modifying Cell Content 
For modifying the cell content just activate the cell, enter a new value and 

then press enter or navigation key to see the changes. See the screen-shot 

below to understand it. 
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Delete Data in Excel 

MS Excel provides various ways of deleting data in the sheet. Let us see 

those ways. 

Delete with Mouse 
Select the data you want to delete. Right Click on the sheet. Select 

the delete option, to delete the data. 
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Delete with Delete Key 
Select the data you want to delete. Press on the Delete Button from the 

keyboard, it will delete the data. 

Selective Delete for Rows 
Select the rows, which you want to delete with Mouse click + Control 

Key. Then right click to show the various options. Select the Delete 

option to delete the selected rows. 
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Move Data in Excel 

Let us see how we can Move Data with MS Excel. 

Step 1 − Select the data you want to Move. Right Click and Select the cut 

option. 
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Step 2 − Select the first cell where you want to move the data. Right 

click on it and paste the data. You can see the data is moved now. 
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Rows & Columns in Excel 

Row and Column Basics 
MS Excel is in tabular format consisting of rows and columns. 

 Row runs horizontally while Column runs vertically. 

 Each row is identified by row number, which runs vertically at the left side of the 

sheet. 

 Each column is identified by column header, which runs horizontally at the top of 

the sheet. 

For MS Excel 2010, Row numbers ranges from 1 to 1048576; in 

total 1048576 rows, and Columns ranges from A to XFD; in 

total 16384 columns. 

Navigation with Rows and Columns 
Let us see how to move to the last row or the last column. 
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 You can go to the last row by clicking Control + Down Navigation arrow. 

 You can go to the last column by clicking Control + Right Navigation arrow. 

 

Cell Introduction 
The intersection of rows and columns is called cell. 

Cell is identified with Combination of column header and row number. 

For example − A1, A2. 
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Copy & Paste in Excel 

MS Excel provides copy paste option in different ways. The simplest 

method of copy paste is as below. 

Copy Paste 
 To copy and paste, just select the cells you want to copy. Choose copy 

option after right click or press Control + C. 

 Select the cell where you need to paste this copied content. Right click and 

select paste option or press Control + V. 
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In this case, MS Excel will copy everything such as values, formulas, 

Formats, Comments and validation. MS Excel will overwrite the content with 

paste. If you want to undo this, press Control + Z from the keyboard. 

Copy Paste using Office Clipboard 
When you copy data in MS Excel, it puts the copied content in Windows and 

Office Clipboard. You can view the clipboard content by Home → 

Clipboard. View the clipboard content. Select the cell where you need to 

paste. Click on paste, to paste the content. 
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Copy Paste in Special way 
You may not want to copy everything in some cases. For example, you 

want to copy only Values or you want to copy only the formatting of cells. 

Select the paste special option as shown below. 
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Below are the various options available in paste special. 

 All − Pastes the cell’s contents, formats, and data validation from the Windows 

Clipboard. 

 Formulas − Pastes formulas, but not formatting. 

 Values − Pastes only values not the formulas. 

 Formats − Pastes only the formatting of the source range. 

 Comments − Pastes the comments with the respective cells. 

 Validation − Pastes validation applied in the cells. 

 All using source theme − Pastes formulas, and all formatting. 

 All except borders − Pastes everything except borders that appear in the 

source range. 
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 Column Width − Pastes formulas, and also duplicates the column width of the 

copied cells. 

 Formulas & Number Formats − Pastes formulas and number formatting only. 

 Values & Number Formats − Pastes the results of formulas, plus the number. 

 Merge Conditional Formatting − This icon is displayed only when the copied 

cells contain conditional formatting. When clicked, it merges the copied 

conditional formatting with any conditional formatting in the destination range. 

 Transpose − Changes the orientation of the copied range. Rows become 

columns, and columns become rows. Any formulas in the copied range are 

adjusted so that they work properly when transposed. 

 
Text Alignments in Excel 
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Change Alignment from Home Tab 
You can change the Horizontal and vertical alignment of the cell. By default, 

Excel aligns numbers to the right and text to the left. Click on the available 

option in the Alignment group in Home tab to change alignment. 

 

Change Alignment from Format Cells 
Right click on the cell and choose format cell. In format cells dialogue, 

choose Alignment Tab. Select the available options from the Vertical 

alignment and Horizontal alignment options. 
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Exploring Alignment Options 
1. Horizontal Alignment − You can set horizontal alignment to Left, 

Centre, Right, etc. 

 Left − Aligns the cell contents to the left side of the cell. 

 Center − Centers the cell contents in the cell. 

 Right − Aligns the cell contents to the right side of the cell. 

 Fill − Repeats the contents of the cell until the cell’s width is filled. 

 Justify − Justifies the text to the left and right of the cell. This option is 

applicable only if the cell is formatted as wrapped text and uses more than one 

line. 

2. Vertical Alignment − You can set Vertical alignment to top, Middle, 

bottom, etc. 

 Top Aligns the cell contents to the top of the cell. 

 Center Centers the cell contents vertically in the cell. 

 Bottom Aligns the cell contents to the bottom of the cell. 
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 Justify Justifies the text vertically in the cell; this option is applicable only if the 

cell is formatted as wrapped text and uses more than one line. 

Merge & Wrap in Excel 
Merge Cells 

MS Excel enables you to merge two or more cells. When you merge cells, 

you don’t combine the contents of the cells. Rather, you combine a group of 

cells into a single cell that occupies the same space. 

You can merge cells by various ways as mentioned below. 

 Choose Merge & Center control on the Ribbon, which is simpler. To merge 

cells, select the cells that you want to merge and then click the Merge & Center 

button. 

 

 Choose Alignment tab of the Format Cells dialogue box to merge the cells. 
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Additional Options 
The Home » Alignment group » Merge & Center control contains a 

drop-down list with these additional options − 

 Merge Across − When a multi-row range is selected, this command creates 

multiple merged cells — one for each row. 

 Merge Cells − Merges the selected cells without applying the Center attribute. 

 Unmerge Cells − Unmerges the selected cells. 

Wrap Text and Shrink to Fit 
If the text is too wide to fit the column width but don’t want that text to 

spill over into adjacent cells, you can use either the Wrap Text option or the 

Shrink to Fit option to accommodate that text. 
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Borders and Shades in Excel 

Apply Borders 
MS Excel enables you to apply borders to the cells. For applying border, 

select the range of cells Right Click » Format cells » Border Tab » 

Select the Border Style. 
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Then you can apply border by Home Tab » Font group » Apply Borders. 
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Apply Shading 
You can add shading to the cell from the Home tab » Font Group » 

Select the Color. 
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Header and Footer in Excel 

Header and Footer 
A header is the information that appears at the top of each printed page 

and a footer is the information that appears at the bottom of each printed 

page. By default, new workbooks do not have headers or footers. 

Adding Header and Footer 

 Choose Page Setup dialog box » Header or Footer tab. 
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You can choose the predefined header and footer or create your custom 

ones. 

 &[Page] − Displays the page number. 

 &[Pages] − Displays the total number of pages to be printed. 

 &[Date] − Displays the current date. 

 &[Time] − Displays the current time. 

 &[Path]&[File] − Displays the workbook’s complete path and filename. 

 &[File] − Displays the workbook name. 

 &[Tab] − Displays the sheet’s name. 
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Other Header and Footer Options 
When a header or footer is selected in Page Layout view, the Header & 

Footer » Design » Options group contains controls that let you specify 

other options − 

 Different First Page − Check this to specify a different header or footer for the 

first printed page. 

 Different Odd & Even Pages − Check this to specify a different header or 

footer for odd and even pages. 

 Scale with Document − If checked, the font size in the header and footer will 

be sized. Accordingly if the document is scaled when printed. This option is 

enabled, by default. 

 Align with Page Margins − If checked, the left header and footer will be 

aligned with the left margin, and the right header and footer will be aligned with 

the right margin. This option is enabled, by default. 

Insert Page Break in Excel  
Page Breaks 

If you don’t want a row to print on a page by itself or you don't want a table 

header row to be the last line on a page. MS Excel gives you precise control 

over page breaks. 

MS Excel handles page breaks automatically, but sometimes you may want 

to force a page break either a vertical or a horizontal one. so that the 

report prints the way you want. 

For example, if your worksheet consists of several distinct sections, you 

may want to print each section on a separate sheet of paper. 

Inserting Page Breaks 
Insert Horizontal Page Break − For example, if you want row 14 to be 

the first row of a new page, select cell A14. Then choose Page Layout » 

Page Setup Group » Breaks » Insert Page Break. 
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Insert vertical Page break − In this case, make sure to place the pointer 

in row 1. Choose Page Layout » Page Setup » Breaks » Insert Page 

Break to create the page break. 
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Removing Page Breaks 
 Remove a page break you’ve added − Move the cell pointer to the first row 

beneath the manual page break and then choose Page Layout » Page Setup » 

Breaks » Remove Page Break. 

 Remove all manual page breaks − Choose Page Layout » Page Setup » 

Breaks » Reset All Page Breaks. 

************************************************* 
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UNIT-5 

INTERNET AND CYBER SECURITY 

Introduction 
The Internet is an increasingly important part of everyday life for people 

around the world. But if you've never used the Internet before, all of this new 

information might feel a bit confusing at first. 

Throughout this tutorial, we'll try to answer some basic questions you may have 

about the Internet and how it's used. When you're done, you'll have a good 

understanding of how the Internet works, how to connect to the Internet, 

and how to browse the Web. 

What is the Internet? 

The Internet is a global network of billions of computers and other electronic 

devices. With the Internet, it's possible to access almost any information, 

communicate with anyone else in the world, and do much more. 

You can do all of this by connecting a computer to the Internet, which is also 

calledgoing online. When someone says a computer is online, it's just another 

way of saying it's connected to the Internet. 
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What is the Web? 

The World Wide Web—usually called the Web for short—is a collection of 

different websites you can access through the Internet. A website is made up of 

related text, images, and other resources. Websites can resemble other forms of 

media—like newspaper articles or television programs—or they can be 

interactive in a way that's unique to computers. 

The purpose of a website can be almost anything: a news platform, an 

advertisement, an online library, a forum for sharing images, or an educational 

site like us! 
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Once you are connected to the Internet, you can access and view websites using 

a type of application called a web browser. Just keep in mind that the web 

browser itself is not the Internet; it only displays websites that are stored on the 

Internet. 

How does the Internet work? 

At this point you may be wondering, how does the Internet work? The exact 

answer is pretty complicated and would take a while to explain. Instead, let's 

look at some of the most important things you should know. 

It's important to realize that the Internet is a global network of physical cables, 

which can include copper telephone wires, TV cables, and fiber optic cables. 



300 | P a g e  

 

Even wireless connections like Wi-Fi and 3G/4G rely on these physical cables 

to access the Internet. 

When you visit a website, your computer sends a request over these wires to 

a server. A server is where websites are stored, and it works a lot like your 

computer's hard drive. Once the request arrives, the server retrieves the website 

and sends the correct data back to your computer. What's amazing is that this all 

happens in just a few seconds!  

Watch the video below from Tata Communications to learn more about how the 

Internet functions. 

Other things you can do on the Internet 

One of the best features of the Internet is the ability to communicate almost 

instantly with anyone in the world. Email is one of the oldest and most 

universal ways to communicate and share information on the Internet, and 

billions of people use it. Social media allows people to connect in a variety of 

ways and build communities online. 

http://www.gcflearnfree.org/email101
http://www.gcflearnfree.org/topics/socialmedia
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There are many other things you can do on the Internet. There are thousands of 

ways to keep up with news or shop for anything online. You can pay your 

bills, manage your bank accounts, meet new people, watch TV, or learn new 

skills. You can learn or do almost anything online. 

Lesson 2: What Can You Do Online? 

Introduction 
There's almost no limit to what you can do online. The Internet makes it 

possible to quickly find information, communicate with people around the 

world, manage your finances, shop from home, listen to music, watch videos, 

http://www.gcflearnfree.org/using-the-web-to-get-stuff-done/online-shopping-advice/1
http://www.gcflearnfree.org/online-money-tips/online-banking-101/1
http://www.gcflearnfree.org/using-the-web-to-get-stuff-done/streaming-video-services/1
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and much, much more. Let's take a look at some of the ways the Internet is most 

commonly used today. 

Finding information online 

With billions of websites online today, there is a lot of information on the 

Internet. Search engines make this information easier to find. All you have to 

do is type one or more keywords, and the search engine will look 

for relevant websites. 

For example, let's say you're looking for a new pair of shoes. You could use a 

search engine to learn about different types of shoes, get directions to a nearby 

shoe store, or even find out where to buy them online! 
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There are many different search engines you can use, but some of the most 

popular include Google, Yahoo!, and Bing. 

Email 

Short for electronic mail, email is a way to send and receive messages across 

the Internet. Almost everyone who uses the Internet has their own email 

http://www.google.com/
http://www.yahoo.com/
http://www.bing.com/
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account, usually called an email address. This is because you'll need an email 

address to do just about anything online, from online banking to creating a 

Facebook account. 

 

Social networking 

Social networking websites are another way to connect and share with your 

family and friends online. Rather than sharing with just a few people over email, 

social networks make it easier to connect and share with many people at the 

same time. Facebook is the world's largest social networking site, with more 

than 1 billion users worldwide. 

http://www.facebook.com/
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Chat and instant messaging 

Chat and instant messaging (IM) are short messages sent and read in real 

time, allowing you to converse more quickly and easily than email. These are 

generally used when both (or all) people are online, so your message can be 

read immediately. By comparison, emails won't be seen until recipients check 

their inboxes. 
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Examples of instant messaging applications include Yahoo 

Messenger and Google Hangouts. Some sites, like Gmail and Facebook, even 

allow you to chat within your web browser. 

Online media 

There are many sites that allow you to watch videos and listen to music. For 

example, you can watch millions of videos on YouTube or listen to Internet 

radio on Pandora. Other services, like Netflix and Hulu, allow you to watch 

movies and TV shows. And if have a set-top streaming box, you can even 

watch them directly on your television instead of a computer screen. 

https://www.youtube.com/
http://www.pandora.com/
http://www.netflix.com/
http://www.hulu.com/
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Everyday tasks 

You can also use the Internet to complete many everyday 

tasks and errands. For example, you can manage your bank account, pay your 

bills, and shop for just about anything. The main advantage here 

is convenience. Rather than going from place to place, you can do all of these 

tasks at home! 
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And a whole lot more! 

Remember, these are just a few of the things you'll be able to do online. Keep 

working through this tutorial to learn more about connecting to the Internet and 

using the Web! 
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Lesson 3: Connecting to the Internet 

How do I connect to the 

Internet? 
Once you've set up your computer, you may want to purchase home Internet 

access so you can send and receive email, browse the Web, stream videos, and 

more. You may even want to set up a home wireless network, commonly 

known as Wi-Fi, so you can connect multiple devices to the Internet at the same 

time. 

Watch the video below to learn about connecting to the Internet. 

Types of Internet service 
The type of Internet service you choose will largely depend on which Internet 

service providers (ISPs) serve your area, along with the types of service they 

offer. Here are some common types of Internet service. 

 Dial-up: This is generally the slowest type of Internet connection, 

and you should probably avoid it unless it is the only service 

available in your area. Dial-up Internet uses your phone line, so 

unless you have multiple phone lines you will not be able to use 

your landline and the Internet at the same time. 

 DSL: DSL service uses a broadband connection, which makes it 

much faster than dial-up. DSL connects to the Internet via a phone 

line but does not require you to have a landline at home. And 

unlike dial-up, you'll be able to use the Internet and your phone line 

at the same time. 
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 Cable: Cable service connects to the Internet via cable TV, 

although you do not necessarily need to have cable TV in order to 

get it. It uses a broadband connection and can be faster than both 

dial-up and DSL service; however, it is only available where cable 

TV is available. 

 Satellite: A satellite connection uses broadband but does not 

require cable or phone lines; it connects to the Internet through 

satellites orbiting the Earth. As a result, it can be used almost 

anywhere in the world, but the connection may be affected by 

weather patterns. Satellite connections are also usually slower than 

DSL or cable. 

 3G and 4G: 3G and 4G service is most commonly used with 

mobile phones, and it connects wirelessly through your ISP's 

network. However, these types of connections aren't always as fast 

as DSL or cable. They will also limit the amount of data you can 

use each month, which isn't the case with most broadband plans. 

Choosing an Internet service 

provider 
Now that you know about the different types of Internet service, you can do 

some research to find out what ISPs are available in your area. If you're having 

trouble getting started, we recommend talking to friends, family members, and 

neighbors about the ISPs they use. This will usually give you a good idea of the 

types of Internet service available in your area.  

Most ISPs offer several tiers of service with different Internet speeds, usually 

measured in Mbps (short for megabits per second). If you mainly want to use 

the Internet for email and social networking, a slower connection (around 2 to 

5 Mbps) might be all you need. However, if you want 

to download music or stream videos, you'll want a faster connection (at least 5 

Mbps or higher). 
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You'll also want to consider the cost of the service, including installation 

charges and monthly fees. Generally speaking, the faster the connection, the 

more expensive it will be per month.  

Although dial-up has traditionally been the least expensive option, many ISPs 

have raised dial-up prices to be the same as broadband. This is intended to 

encourage people to switch to broadband. We do not recommend dial-up 

Internet unless it's your only option. 

Hardware needed 

Modem 

 

Once you have your computer, you really don't need much additional hardware 

to connect to the Internet. The primary piece of hardware you need is a modem. 

The type of Internet access you choose will determine the type of modem you 

need. Dial-up access uses a telephone modem, DSL service uses a DSL 

modem, cable access uses a cable modem, and satellite service uses a satellite 
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adapter. Your ISP may give you a modem—often for a fee—when you sign a 

contract, which helps ensure that you have the right type of modem. However, 

if you would prefer to shop for a better or less expensive modem, you can 

choose to buy one separately. 

Router 

 

A router is a hardware device that allows you to connect several 

computers and other devices to a single Internet connection, which is known 

as a home network. Many routers are wireless, which allows you to create 

a home wireless network, commonly known as a Wi-Fi network. 

You don't necessarily need to buy a router to connect to the Internet. It's 

possible to connect your computer directly to your modem using an Ethernet 

cable. Also, many modems include a built-in router, so you have the option of 

creating a Wi-Fi network without buying extra hardware. 
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Setting up your Internet 

connection 
Once you've chosen an ISP, most providers will send a technician to your 

house to turn on the connection. If not, you should be able to use the 

instructions provided by your ISP—or included with the modem—to set up your 

Internet connection. 

After you have everything set up, you can open your web browser and begin 

using the Internet. If you have any problems with your Internet connection, you 

can call your ISP's technical support number. 

Home networking 
If you have multiple computers at home and want to use all of them to access 

the Internet, you may want to create a home network, also known as a Wi-Fi 

network. In a home network, all of your devices connect to your router, which 

is connected to the modem. This means everyone in your family can use the 

Internet at the same time. 

Your ISP technician may be able to set up a home Wi-Fi network when 

installing your Internet service. If not, you can review our lesson on How to Set 

Up a Wi-Fi Network to learn more.  

If you want to connect a computer that does not have built-in Wi-Fi 

connectivity, you can purchase a Wi-Fi adapter that plugs into your computer's 

USB port. 

http://www.gcflearnfree.org/basic-computer-skills/how-to-set-up-a-wifi-network/1/
http://www.gcflearnfree.org/basic-computer-skills/how-to-set-up-a-wifi-network/1/
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What is the cloud? 

You may have heard people using terms like the cloud, cloud computing, 

or cloud storage. But what exactly is the cloud? 

Simply put, the cloud is the Internet—more specifically, it's all of the things 

you can access remotely over the Internet. When something is in the cloud, it 

means it's stored on Internet servers instead of your computer's hard drive. 

Why use the cloud? 

Some of the main reasons to use the cloud are convenience and reliability. For 

example, if you've ever used a web-based email service, such 

as Gmail or Yahoo! Mail, you've already used the cloud. All of the emails in a 

web-based service are stored on servers rather than on your computer's hard 

drive. This means you can access your email from any computer with an 

Internet connection. It also means you'll be able to recover your emails if 

something happens to your computer. 
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Let's look at some of the most common reasons to use the cloud.  

 File storage: You can store all types of information in the cloud, 

including files and email. This means you can access these things 

from any computer or mobile device with an Internet connection, 

not just your home computer. Dropbox and Google Drive are 

some of the most popular cloud-based storage services. 

 File sharing: The cloud makes it easy to share files with several 

people at the same time. For example, you could upload several 

photos to a cloud-based photo service like Flickr or iCloud 

Photos, then quickly share them with friends and family. 

 Backing up data: You can also use the cloud to protect your files. 

Apps like Mozy and Carbonite automatically back up your 

data to the cloud. This way, if your computer ever is lost, stolen, or 

damaged, you'll still be able to recover these files from the cloud. 

 

https://www.dropbox.com/
http://www.google.com/drive
http://www.flickr.com/
http://www.apple.com/icloud/photos/
http://www.apple.com/icloud/photos/
http://mozy.com/
http://www.carbonite.com/
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What is a web app? 

Previously, we talked about how desktop applications allow you to perform 

tasks on your computer. But there are also web applications—or web apps—

that run in the cloud and do not need to be installed on your computer. Many of 

the most popular sites on the Internet are actually web apps. You may have even 

used a web app without realizing it! Let's take a look at some popular web apps. 

 Facebook: Facebook lets you create an online profile and interact 

with your friends. Profiles and conversations can be updated at any 

time, so Facebook uses web app technologies to keep the 

information up to date. 

 

 Pixlr: Pixlr is an image editing application that runs in your web 

browser. Much like Adobe Photoshop, it includes many advanced 

features, like color correction and sharpening tools. 

https://www.facebook.com/
https://pixlr.com/
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 Google Docs: Google Docs is an office suite that runs in your 

browser. Much like Microsoft Office, you can use it to 

create documents, spreadsheets, presentations, and more. And 

because the files are stored in the cloud, it's easy to share them 

with others. 

https://docs.google.com/
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URLs and the address bar 

Each website has a unique address, called a URL (short for Uniform Resource 

Locator). It's like a street address that tells your browser where to go on the 

Internet. When you type a URL into the browser's address bar and 

press Enter on your keyboard, the browser will load the page associated with 

that URL. 

In the example below, we've typed www.bbc.com/travel into the address bar. 

 

http://www.bbc.com/travel
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Links 

Whenever you see a word or phrase on a website that's blue or underlined in 

blue, it's probably a hyperlink, or link for short. You might already know how 

links work, even if you've never thought about them much before. For example, 

try clicking the link below. 

Hey, I'm a link! Click me! 

Links are used to navigate the Web. When you click a link, it will usually take 

you to a different webpage. You may also notice that your cursor changes into 

a hand icon whenever you hover over a link. 

 

If you see this icon, it means you've found a link. You'll find other types of links 

this way too. For example, many websites actually use images as links, so you 

can just click the image to navigate to another page. 

Navigation buttons 

The Back and Forward buttons allow you to move through websites 

you've recently viewed. You can also click and hold either button to see your 

recent history. 

http://www.google.com/
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The Refresh button will reload the current page. If a website stops working, try 

using the Refresh button. 

 

Tabbed browsing 

Many browsers allow you to open links in a new tab. You can open as many 

links as you want, and they'll stay in the same browser window instead of 

cluttering your screen with multiple windows. 

To open a link in a new tab, right-click the link and select Open link in new 

tab (the exact wording may vary from browser to browser). 
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To close a tab, click the X. 

 

To create a new blank tab, click the button to the right of any open tabs. 
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Bookmarks and history 

If you find a website you want to view later, it can be hard to memorize the 

exact web address. Bookmarks, also known as favorites, are a great way to 

save and organize specific websites so you can revisit them again and again. 

Simply locate and select the Star icon to bookmark the current website. 

 

Your browser will also keep a history of every site you visit. This is another 

good way to find a site you visited previously. To view your history, open your 

browser settings—usually by clicking the icon in the upper-right corner—and 

select History. 
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Downloading files 

Links don't always go to another website. In some cases, they point to a file that 

can be downloaded, or saved, to your computer. 

If you click a link to a file, it may download automatically, but sometimes it 

just opens within your browser instead of downloading. To prevent it from 

opening in the browser, you can right-click the link and select Save link 

as (different browsers may use slightly different wording, like Save target as). 
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Using search engines 

With billions of websites online today, there is a lot of information on the 

Internet. Search engines make this information easier to find. Let's look at the 

basics of using a search engine, as well as some techniques you can use to 

get better search results. 

How to search the Web 

There are many different search engines you can use, but some of the most 

popular include Google, Yahoo!, and Bing. To perform a search, you'll need to 

navigate to a search engine in your web browser, type one or more keywords—

also known as search terms—then press Enter on your keyboard. In this 

example, we'll search for recipes. 

http://www.google.com/
http://www.yahoo.com/
http://www.bing.com/
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After you run a search, you'll see a list of relevant websites that match your 

search terms. These are commonly known as search results. If you see a site 

that looks interesting, you can click a link to open it. If the site doesn't have 

what you need, you can simply return to the results page to look for more 

options. 
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Most browsers also allow you to perform a web search directly from 

your address bar, although some have a separate search bar next to the 

address bar. Simply type your search terms and press Enter to run the search. 



327 | P a g e  

 

 

Search suggestions 

If you don't find what you're looking for on the first try, don't worry! Search 

engines are good at finding things online, but they're not perfect. You'll often 

need to try different search terms to find what you're looking for. 

If you're having trouble thinking of new search terms, you can use search 

suggestions instead. These will usually appear as you're typing, and they're a 

great way to find new keywords you might not have tried otherwise. To use a 

search suggestion, you can click it with your mouse, or select it with the arrow 

keys on your keyboard. 
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Refining your search 

If you're still having trouble finding exactly what you need, you can use some 

special characters to help refine your search. For example, if you want 

to exclude a word from a search, you can type a hyphen (-) at the beginning of 

a word. So if you wanted to find cookie recipes that don't include chocolate, you 

could search for recipes cookies -chocolate. 
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You can also search for exact words or phrases to narrow down your results 

even more. All you need to do is place quotation marks (" ") around the 

desired search terms. For example, if you search for recipes "sugar cookies", 

your search results will only include recipes for sugar cookies, instead of any 

cookies that happen to use sugar as an ingredient. 
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These techniques may come in handy in certain cases, but you probably won't 

need to use them with most searches. Search engines can usually figure out what 

you're looking for without these extra characters. We recommend trying a few 

different search suggestions before using this method.  
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Content-specific searches 

There may be times when you're looking for something more specific, like 

a news article, picture, or video. Most search engines have links at the top of 

the page that allow you to perform these unique searches. 

 

In the example below, we've used the same search terms to look 

for images instead of websites. If you see an image you like, you can click to 

visit the website it originally came from.  
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You can use the extra search tools to narrow down your results even more. 

These tools will change based on the type of content you're looking for, but in 

this example we can filter our images by size, color, image type, and more. So 

if you wanted to find cookies with pink frosting, you could search for images 

that are mostly pink. 
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Advertisements 

One final thing to note: Most search engines include advertisements with 

search results. For example, you can see advertisements at the top of the search 

results below. 
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These ads are based on your search terms, and they often look similar to other 

search results. While they may be useful in some cases, it's usually more helpful 

to focus on the actual search results. 

How to send an email 
Follow these step-by-step instructions to send an email 

Step 1: Log in to your Gmail account so that you are on the dashboard (main page) of your mail 

account. 

Step 2: Click Compose. 



335 | P a g e  

 

 

Step 3: A new blank email window will open up. In the ‘To’ box, type in the email address of 

the recipient. 
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Step 4: You might want to include someone else in your email to ‘keep them in the loop’. You 

can do this by clicking Cc or Bcc, which will open another field. ‘Cc’ means ‘carbon copy’ and 

‘Bcc’ means ‘blind carbon copy’. Adding an email address to the ‘Cc’ field means that that 

person will receive a copy of the email and all the other recipients will see their email address. If 

an email address is put into the 'Bcc’ field, the person will get a copy of the email but no other 

recipient will see that address. 

If you are sending the same email to lots of different people, it’s a good idea to put all the email 

addresses in the ‘Bcc’ field to keep your ‘mailing list’ confidential. That way, there’s no chance 

that it could fall into the hands of a spammer or hacker. 
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Step 5: The subject field allows you to give the recipient an idea of the topic of your email, like 

a heading. You don’t have to put anything in the subject box, but it can help when viewing and 

sorting email. 

Step 6: Email text can be formatted in a similar way to text in a word document. You can change 

the font style, colour and size using the formatting icons. You can also create bullet points and 

check the spelling of your email. Choose your formatting from the menu shown. 
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Step 7: Type your message in the main body field of your email. 

 

You can format your email using the options that are available on the toolbar. To add a link in 

the body of your email click on the insert link icon, then add the 'Text to display' and then a 

web or email address, finally click OK. 
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Step 8: When you’re happy with your email, click the blue Send button at the bottom of the 

compose window. 
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Step 9: The email you’ve sent will now be stored in the ‘Sent Mail’ folder on your Gmail 

dashboard. You may have to run your mouse pointer over the Inbox folder link to see the other 

folders. 
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Step 10: You may start an email but then decide to come back to it later rather then sending it 

straightaway. Gmail saves your drafts automatically. So you can simply close the email and the 

unfinished email will be saved to your ‘Drafts’ folder.  When you decide that you’re ready to 

send it, you can retrieve it from the ‘Drafts’ folder by clicking Drafts and then clicking the 

correct item in the ‘Drafts’ folder list. Finish the email and click Send as normal. 

1. Different Virus Expressions 

Virus 

A computer virus is a piece of software that can 'infect' a computer, install itself and copy itself to other 

computers, without the users knowledge or permission. It usually attaches itself to other computer programs, 

data files, or the boot sector of a Hard drive. 

Malware 

Malware is short for malicious software. Malware is the name given to any type of software that could harm a 

computer system, interfere with and gather a user's data, or make the computer perform actions without the 

owner's knowledge or permission. 

Trojan horse 

A type of malware that uses malicious code to install software that seems ok, but is hidden to create back doors 

into a system typically causing loss or theft of data from an external source. 
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Worm 

Unlike a virus, a worm, is a standalone piece of malicious software that replicates itself in order to spread to 

other computers. It often uses a computer network to spread itself, relying on security flaws on the target 

system to allow access. 

Spyware 

Spyware is software that aids in gathering information about a person or organization without their knowledge, 

they can monitor and log the activity performed on a target system, like log key strokes, or gather credit card 

and other information. 

Adware 

Adware is software which can automatically causes pop-up and banner adverts to be displayed in order to 

generate revenue for its author or publisher. A lot of freeware will use Adware but not always in a malicious 

way, if it was malicious, it would then be classed as spyware or malware. 

Back to Top 

 

2. How Can a Computer Be Protected from Viruses? 

 Install an anti-virus program and keep it up-to-date and regularly run scans. 

 Install an anti-malware program to stop software installing without your knowledge. 

 Never download and install software from the Internet unless you are certain it is from a trusted 

source. 

 Don’t open e-mail attachments unless you have scanned them first, even a picture can carry a virus. 

 Don’t trust cracked or hacked software as they often contain malware, Trojans. 

Anti-virus software is a software utility that detects, prevents, and removes 

viruses, worms, and other malware from a computer. Most anti-virus programs include 
an auto-update feature that permits the program to download profiles f new viruses, 
enabling the system to check for new threats. Antivirus programs are essential utilities 
for any computer but the choice of which one is very important. One AV program might 
find a certain virus or worm while another cannot, or vice-versa. 

Types of Antivirus Programs 

Anybody who accesses the internet can benefit from knowing about various antivirus 

programs that enable you to stay safe while online. Accessing websites leaves the way 

open for unscrupulous people to infect your computer to secretly gather information 

or spy on what you do. By installing suitable software, you can prevent viruses from 

invading your home computer. 

 

https://www.dell.com/support/article/in/en/indhs1/sln265920/what-are-the-different-types-of-viruses-spyware-and-malware-that-can-infect-my-computer-?lang=en#top
https://www.doityourself.com/stry/7-different-types-of-computer-viruses-and-spyware
https://www.doityourself.com/stry/how-to-install-antivirus-software-on-multiple-computers
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1. AVG 

AVG is one of the most popular antivirus programs that can be obtained for free, and 

it’s easy to download directly from the internet. In addition to not taking up a 

significant amount of space on a hard drive, it can also work with a number of 

different Windows operating systems. It incorporates both antivirus and antispyware 

abilities and works by scanning all the files on the computer at regular intervals. 

Additionally, it has the ability to quarantine virus files so that they cannot do any 

harm before they can be checked and deleted. 

2. McAfee 

McAfee VirusScan has been the second most popular antivirus program on the market 

for years, which has enabled the company to cement their position as a strong 

competitor to Symantec. It provides spyware and virus protection within one program, 

rather than separately as many other programs do. It is necessary to take out a 

subscription to use McAfee, but it will give you access to continuously updating virus 

protection. 

3. Norton 

There are a number of Norton antivirus programs available, all produced by 

Symantec. They have quickly proven themselves to be a market leader when it comes 

to computer system security, with their products available from a range of different 

electronics supply stores. Norton programs are used by the majority of computer users 

on the market, who pay an annual fee for a subscription service. Norton Anti-Virus 

and Norton Internet Security are software programs that search the computer regularly 

and delete any viruses that they find. 

4. Kaspersky 

Russian-developed Kaspersky is not the most popular of all the antivirus protection 

programs; many people have probably never heard of them. However, they still 

provide a very effective product for protection against viruses, spyware, and Trojans. 

Kaspersky Internet Security and Kaspersky Antivirus prevent problems that 

computers will encounter in the event that they become infected. 

5. Ad Aware 

This software by Lavasoft is another antivirus program that provides protection 

against a large number of cyber security threats that arise from using the Internet. 

They offer different levels of protection according to how much you want to spend in 
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a one-off payment for the program. In addition to finding and removing viruses and 

spyware that can detect key strokes and passwords, it will protect against Trojans. 

Advancements in anti-malware technology allow it to provide effective protection 

while not putting excessive pressure on the system in the process. 

 

Definition of 'Cyber Security' 
 

Definition: Cyber security or information technology security are the techniques of 

protecting computers, networks, programs and data from unauthorized access or attacks 

that are aimed for exploitation. 

 

Description: Major areas covered in cyber security are: 

 

1) Application Security 

 

2) Information Security 

 

3) Disaster recovery 

 

4) Network Security 

 

Application security encompasses measures or counter-measures that are taken during 

the development life-cycle to protect applications from threats that can come through 

flaws in the application design, development, deployment, upgrade or maintenance. 

Some basic techniques used for application security are: a) Input parameter 

validation, b) User/Role Authentication & Authorization, c) Session management, 

parameter manipulation & exception management, and d) Auditing and logging. 

 

Information security protects information from unauthorized access to avoid identity theft 

and to protect privacy. Major techniques used to cover this are: a) Identification, 

authentication & authorization of user, b) Cryptography. 

 

Disaster recovery planning is a process that includes performing risk assessment, 
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establishing priorities, developing recovery strategies in case of a disaster. Any business 

should have a concrete plan for disaster recovery to resume normal business operations 

as quickly as possible after a disaster. 

 

Network security includes activities to protect the usability, reliability, integrity and safety 

of the network. Effective network security targets a variety of threats and stops them 

from entering or spreading on the network. Network security components 

include: a) Anti-virus and anti-spyware, b) Firewall, to block unauthorized access to your 

network, c) Intrusion prevention systems (IPS), to identify fast-spreading threats, such 

as zero-day or zero-hour attacks, and d) Virtual Private Networks (VPNs), to provide 

secure remote access. 

Firewall : 
Also known as a 'packet filter'. Basically, software which monitors network 

traffic and connection attempts into and out of a network or computer and determines whether 

or not to allow it to pass. Depending on the sophistication, this can be limited to simple 
IP/port combinations or do full content-aware scans. 
A firewall can be thought of as a screen or sieve that categorically strains out potentially 
harmful data. 

Antivirus: 
A software which will find programs/files/software/etc that might compromise your computer, 
either by being executable or by exploiting a vulnerability in the program normally supposed 
to process them -- Rootkits, trojans, or other types of malware. 

It detects these kinds of harmful programs that are already installed on your computer or 
about to be installed. 

It can perform various protective measures (based on the security settings in the Anti-virus 
software) such as quarantine, permanent removal, fix, etc., 

It will also look for potentially harmful files that are downloaded from the internet or attached 
to an email and notifies/removes it to protect your computer. 

Online Transactions Safe & Secure 
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1. Never use public Wi-Fi or a public computer for 
online transaction or money transfer 

 

REUTERS 

Never attempt an online transaction on a public Wi-Fi. They often have 

fewer security features than a private network. So always switch to your 

phone data. 

If you have to do an emergency transaction on a public wifi out of 

emergency, be sure to change it ASAP. 

2. Firewalls and Antivirus 

If you don't have an antivirus app, get one -- ideally if it's a paid one. Put 

your antivirus on auto update. This will ensure that it‟s updated all the time. 

There‟s a new malware on the internet every day. An updated firewall will 

protect you from these. 

Turn your firewall on. Firewalls often block sites that are malicious or 

suspicious. If your firewall blocks a certain website, be sure to avoid it.  
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3. Never reply to fraud emails and texts 

Phishing or the attempt to gain your personal information generally over 

email or text is rampant. Your inbox is probably full of emails, claiming that 

you‟ve won a contest or you‟ve been credited a certain amount of money. 

Never open these emails. Never reply to them. Learn to identify such spam 

mail and ignore them, or if you have the time, delete them. 

 

 Writava Banerjee  

Updated: Jun 19, 2018, 16:29 PM IST 

241 SHARES 

https://www.indiatimes.com/author/writava-banerjee/
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FACEBOOK TWITTER REDDIT 
SAVE

 

We often come across reports where people lose money because their 

account got hacked or someone lost money due to an online fraud. 

Malware, viruses, phishing are common across the internet and the onus is 

on us to protect ourselves from them. 

So here are a few tips you must follow to protect your money online: 

1. Never use public Wi-Fi or a public computer for 
online transaction or money transfer 

 

REUTERS 

Never attempt an online transaction on a public Wi-Fi. They often have 

fewer security features than a private network. So always switch to your 

phone data. 

If you have to do an emergency transaction on a public wifi out of 

emergency, be sure to change it ASAP. 

javascript:void(0)
javascript:void(0)
https://www.reddit.com/submit?url=https%3A%2F%2Fwww.indiatimes.com%2Ftechnology%2Fhow-to-keep-your-online-transactions-safe-secure-11-tips-to-ensure-you-don-t-lose-money-347712.html&title=Keep+Your+Online+Transaction+Safe+%26+11+Tips+To+Ensure+You+Don%27t+Lose+Money+In+Online+Transfer
https://www.reddit.com/submit?url=https%3A%2F%2Fwww.indiatimes.com%2Ftechnology%2Fhow-to-keep-your-online-transactions-safe-secure-11-tips-to-ensure-you-don-t-lose-money-347712.html&title=Keep+Your+Online+Transaction+Safe+%26+11+Tips+To+Ensure+You+Don%27t+Lose+Money+In+Online+Transfer
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2. Firewalls and Antivirus 

If you don't have an antivirus app, get one -- ideally if it's a paid one. Put 

your antivirus on auto update. This will ensure that it‟s updated all the time. 

There‟s a new malware on the internet every day. An updated firewall will 

protect you from these. 

DON'T MISS 
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https://www.indiatimes.com/technology/science-and-future/scientists-have-figured-out-how-to-unboil-eggs-reducing-food-waste-make-drugs-cheaper-361806.html
https://www.indiatimes.com/technology/science-and-future/scientists-have-figured-out-how-to-unboil-eggs-reducing-food-waste-make-drugs-cheaper-361806.html
https://www.indiatimes.com/technology/science-and-future/scientists-have-figured-out-how-to-unboil-eggs-reducing-food-waste-make-drugs-cheaper-361806.html
https://www.indiatimes.com/technology/science-and-future/scientists-have-figured-out-how-to-unboil-eggs-reducing-food-waste-make-drugs-cheaper-361806.html
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Next 

Turn your firewall on. Firewalls often block sites that are malicious or 

suspicious. If your firewall blocks a certain website, be sure to avoid it.  

3. Never reply to fraud emails and texts 

Phishing or the attempt to gain your personal information generally over 

email or text is rampant. Your inbox is probably full of emails, claiming that 

you‟ve won a contest or you‟ve been credited a certain amount of money. 

Never open these emails. Never reply to them. Learn to identify such spam 

mail and ignore them, or if you have the time, delete them. 

https://www.indiatimes.com/technology/
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BCCL/REPRESENTATIVE IMAGE 

4. Check for digital certificates 

Always check for the digital certificates when using a third party payment 

method. Often you can see a symbol like VeriSign‟ on the window, and you 

can click on it to get information on the website‟s certification. 

5. Prefer virtual keyboard 

There are malware and viruses that can make a log of what you type on 

your keyboard. So it‟s advisable to use a virtual keyboard when doing an 

online transaction. Banks have an option for a virtual keyboard on their 

login pages. Use it. 



356 | P a g e  

 

 

CHROME STORE 

6. Enable two-step verification  

If your device doesn‟t have a mandatory two-step verification, make sure to 

turn it on. Two-step verification involves passing two security walls to 

perform an operation on your phone. For eg, Google's two-step verification 

ask you to verify yourself by asking you your password, pattern or 

fingerprint first and then they divert you to your bank‟s website. 

7. Check if the connection is secure 

Always check for the lock symbol on the address bar and check if „https://‟ 

is in green. It means that the connection is secure. If it‟s yellow or red, 

never attempt an online transaction as it might make your information 

vulnerable. 

8. Always track your online spending 

Keep track of your bank balance and how much you spend online. It‟s 

better to dedicate just one credit or debit card for online transactions. This 
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makes tracking your online spending easier. If you find any suspicious 

behaviour, check with your bank immediately. 

 
BCCL/REPRESENTATIVE IMAGE 

9. Private Browsing 

Another way to protect your information is private browsing like the 

incognito mode on google chrome. Private browsing doesn‟t save 

passwords or create history and it clears all the cookies and cache data 

from your device. 
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YOUTUBE 

10. Always mind your password  

Protecting your password is extremely critical and there are several key 

points you must remember: 

a) Never share your password with anyone, even your family members.  

b) If you‟ve written it down on a piece of paper, make sure to keep it safe. 

Writing your passwords anywhere is inadvisable, though. 

c) Change your password often, preferably after 2-3 months.  

d) Never keep the same password for all your accounts. If one of your 

accounts is hacked, your other accounts become extremely vulnerable. 

e) Never allow browsers to save your password.  

f) Make your passwords difficult to guess. Make a long password with 

alphanumeric characters and symbols. Make use of both uppercase and 

lowercase letters. 
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11. Don‟t forget to log out 

Never just leave your device without logging out of your account. Most 

banks now have a system, where they automatically log you out after a 

period of inactivity, but it‟s better to do it yourselves. 

Since most of our life is spent online, it‟s out for everybody. Thus it‟s 

critical to protect your information; money being one of them. No one likes 

losing their money, because it‟s hard earned. So being careful will save 

you from losing it. 

************************************* 

 


